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QAD .NET User Interface
Change Summary

The following table summarizes significant differences between this document and the last
published version.

Date/Version Description Reference
April 2016/v2016 EE Rebranded for QAD 2016 EE, added links to Preface and book --
April 2015/v2015 EE Rebranded for QAD 2015 EE -
March 2014/v2014 EE and SE Rebranded for QAD 2014 EE --
March 2013/v2013 EE and SE Rebranded for QAD 2013 EE --

Sept 2012/2012.1 EE and 2012 SE | Rebranded for QAD 2012.1 EE --

Sept 2012/2012.1 EE and 2012 SE | Content edit and update of screens throughout --

March 2012/2012 EE and SE Rebranded for QAD 2012 EE and SE --

Sept 2011/2011.1 EE and 2011 SE | Rebranded for QAD 2011.1 EE --
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Course Description

QAD designed this course to cover the basics of using the QAD .NET User Interface (NET UI)
with both QAD Enterprise Applications Standard Edition (SE) and Enterprise Edition (EE).
The course includes:
« An introduction to the QAD .NET UI
Navigating the QAD .NET Ul
Application help options
QAD .NET Ul programs
Basics of browses

< An introduction to the character user interface

Students will also learn by labs designed to reinforce concepts presented in this training guide.

Objective

Learn how to navigate QAD Enterprise Applications using the QAD .NET UI. In addition,
students will be able understand the help options, different types of programs, and be able to use
browses effectively.

Benefits

Students will become more efficient in the use of QAD Enterprise Applications.

Audience
« Implementation consultants
« Members of implementation teams
» Key users

Prerequisites

Students should have some familiarity with Enterprise (EE) and Standard (SE) editions of QAD
Enterprise Applications.

Course Credit and Scheduling

This course is designed to be taught in two days.

M QAD Questions? Visit community.gad.com
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Virtual Environment Information

This guide applies to both the Standard Edition and the Enterprise Edition of QAD Enterprise
Applications. Use the hands-on exercises in this book with the latest Enterprise Edition learning
environment in the L0USA > 10USACO workspace. When prompted to log in, specify demo for
user ID and gad for password.

Note Users of Standard Edition should complete the exercises in the EE environment; the
concepts are the same in both environments and can be applied to Standard Edition. Features that
only apply to Enterprise Edition are noted in the text.

Additional Resources

If you encounter questions on QAD software that are not addressed in this book, several resources
are available. The QAD corporate Web site provides product and company overviews. From the
main site, you can access the QAD Learning or Support site and the QAD Document Library.
Access to some portions of these sites depends on having a registered account.

http://www.qad.com/

QAD Learning Center

To view available training courses, locations, and materials, use the QAD Learning Center. Choose
Education under the Services tab to access this resource. In the Learning Center, you can reserve a
learning environment if you want to perform self-study and follow a training guide on your own.

QAD Document Library

To access release notes, user guides, training guides, and installation and conversion guides by
product and release, visit the QAD Document Library. Choose Document Library under the
Support tab. In the QAD Document Library, you can view HTML pages online, print specific
pages, or download a PDF of an entire book.

For more information, see QAD .NET Ul Administration Guide.

To find a resource, you can use the navigation tree on the left or use a powerful cross-document
search, which finds all documents with your search terms and lets you refine the search by book
type, product suite or module, and date published.

QAD Support

Support also offers an array of tools depending on your company’s maintenance agreement with
QAD. These include the Knowledgebase and QAD Forums, where you can post questions and
search for topics of interest. To access these, choose Visit Online Support Center under the Support
tab.

Comments? Go to goo.gl/MfwKHm N QAD
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http://documentlibrary.qad.com/documentation/NETUI/EE/index.html#page/NETUI_AG_v2016EE/WhatsNew_netadmin.html
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Objective

Chapter Objective
« Students will be introduced to the following
in the QAD .NET Ul:

- The different types of Ul mode in QAD
Enterprise Applications

- Attributes of component-based and non-
component based programs

- The QAD .NET Ul Login window

M QAD Questions? Visit community.gad.com
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Benefits

Chapter Benefits

« Students will understand the following in the
QAD .NET Ul:

- The different Ul modes available in QAD
Applications

- The different attributes of component-

based and non-component based
screens

- How to log in to the QAD .NET Ul

Comments? Go to goo.gl/MfwKHm MNQAD
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Training Flow

Training Flow

* Introduction

+ Navigation

+ Application Help
- Programs

- Browses

« Character Ul

- Dashboards

M QAD Questions? Visit community.gad.com
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Introduction — QAD .NET Ul

Introduction
« The QAD .NET Ul

- Microsoft Technology
* Incorporates familiar Ul features
* Reduces learning effort by users
- One interface, two modes
+ QAD .NET Ul
« Terminal Mode (rendering of Character Ul)

Comments? Go to goo.gl/MfwKHm MNQAD
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Character Ul

Character Ul

£ 172.16.28.81 - PuTTY =JoJed
QHI : gaddb e
mfmenu Hain Henu 05/z26/ 10‘
1. Items/Sites 13. Product Structures 25. General Ledger
2. Addresses 14. Routings/Work Center 26. Multiple Currency
3. Inventory Control 15. Formula/Process 27. Accounts Receivahle
4. Warehousing 16. Work Orders 28. Accounts Payable
5. Purchasing 17. Lean Hanufacturing 29. Tax Management
& 18. Repetitive 30. Cost Management
7. Sales Orders/Invoice 19. Quality Hanagement 31. Banking/Cash Mgmt
8. Configured Products 20. Product Line Plan 32. Fixed Assets
Da 21. Resource Plan 33. Enterprise Ops Plan
io. 22. Forecast/Haster Plan 34.
11. Service/3Support 23. Materials Rgmts Plan 35. EDI eCommerce
1z. Distribution Plan 24. Capacity Romts Plan 36. System Admin
Please select a function. F4 or blank to EXIT .
Fress FZ for Help ™

Unlike the QAD .NET user interface, the character user interface depends completely on input
from the keyboard. Because it is not a graphical user interface, all navigation is based on:

« A command-prompt interface to execute programs
« Combinations of keystrokes to issue commands within programs
» Navigation without use of a mouse through the UNIX character interface.
Component-based functions are accessible only through the QAD .NET UI. You cannot access any

of these functions from the character Ul. Chapter 6, “Using the Character Ul,” on page 115
discusses this Ul in more detail.

M QAD Questions? Visit community.gad.com
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Terminal Mode in the QAD .NET UI

Iterm Master Maintenance X.

Terminal Mode in the QAD .NET Ul

Fromo Group:

Price Break Category:

Ttem Number: [ Description:
Unit of Measure:
ITtem Data
Prod Line: Item Type: Drawing:
Added: Status: Revision:
Design Group: Group: Drawing Loc: Size:

ABC Class:

Lot/Serial Control:

Site:

Location:

Location Type:
Auto Lot Numbers: No

Lot Group:

Article Number:

Item Inventory Data

Average Interval:
Cycle Count Interval:
Shelf Life:
Allocate Single Lot: No
Key Item: No
PO Receipt Status:
WO Receipt Status:

Rctive: No
Active: No

Memo Order Type:

With the QAD .NET Ul interface, you can still use non-component based programs in a CHUI
interface. You do this by selecting Terminal mode in the Program Properties option. This is
described in Chapter 2 in the topic “Properties Options: Open With” on page 30.

Comments? Go to goo.gl/MfwKHm

MNQAD
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Attributes of Component-Based Programs

Aftributes of Component-Based Screens

- Underlying Microsoft .NET technology
 Traditional Windows screen navigation
- Familiar click and point functions

- Right-click options

M QAD Questions? Visit community.gad.com


http://community.qad.com
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Component-Based QAD .NET Ul Screen

Component-Based Screen
Journal Entry Create *
4 GoTo ~ Actions ~ % Tools »| # Attach | & Print s Preview
Attachments )
Yo d | 08 Pasting Diste oa/30200 -
Dapbook Code » |¢| DDODDOCOO Save As Template
Descrption Template Code Replacemant
Orignal Posting 000000000
Felerence
GL Account 4 GLDescription ¢ SubéccountC 4 CostCe ¢ Description ¢ Trans 4 TC Detat [ TC Credit ¢ Intercompary Code ¢
L4
4| [} »
CutencyView  [Tiansacton Curency  » Tl TC 000 000]
Saveand Create “ Save Close

You use traditional mouse clicks, tabs, and keyboard tabbing to navigate the component-based
screen.

Comments? Go to goo.gl/MfwKHm MNQAD
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Attributes of Non-Component Based Screens

Aftributes of Non-Component Based Screens
A rendering of the Character Ul for the .NET
Ul
Similar tabbing and keyboard navigation

Screen navigation bar for some non-
component based screens
- Enabledin Tools | Options

Non-component based screens are based on traditional procedural-written Progress-based
technology.

M QAD Questions? Visit community.gad.com
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Non-Component Based QAD .NET Ul Screen

Non-Component Based Screen

[Sales Order Maintenance -
# GoTo ~ Actions ~ Copy ~ 5 Print s/ Preview & Aftach
Sales Order (»)  Drder.
Header Lines
> Header » 4 » > >
Header
Order || SoldTo Bil Tor
Sold-Ta Ship-Ta
Details
Order Date: Line Pricing: Confirmed:
Required D ate: Manual Currency:
Fromise D ate Daybook Sel T anable
Due Date: Channel
Perform D ate: Project:

Ship-Ta

Language:

Fised Pnce;
Credt Tems:

All Standard Edition are non-component based. All Enterprise Edition programs except QAD
Enterprise Financials and some related system administration functions are also non-component

based.

Comments? Go to goo.gl/MfwKHm

MNQAD
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Login Menu

Login Menu

Login X

FRAQAD

Enterprise Applications

User. \ |
Password: ! |

Log on to: iuadui - |

Starting the QAD .NET Ul
To launch the client, select the QAD Applications icon or menu item under Programs on the Start

menu. Enter your assigned user ID and password. Select a system environment for which you have
permissions from the drop-down menu.

M QAD Questions? Visit community.gad.com


http://community.qad.com
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Summary

Chapter Summary

There are different types of Ul mode within
the QAD .NET Ul

Component and non-component based
screens have different visual and navigation
afttributes

You launch the QAD .NET Ul from a menu
option or desktop icon and select an
environment from the drop-down menu

Exercise and Knowledge Check

1 You can use the mouse for certain functions in Terminal mode. (T/F)
2 Some component-based functions are configurable in Terminal mode. (T/F)
3 Which of the two interfaces depends completely on input from the keyboard?

4 Which Enterprise Edition application is component based?

Comments? Go to goo.gl/MfwKHm MNQAD
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M QAD Questions? Visit community.gad.com


http://community.qad.com
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Navigating the QAD .NET UI
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Objective

Chapter Objectives

- Understand general navigation features of
the QAD .NET Ul

« Know how to use the Workspace menus

+ Understand navigation differences in
different types of programs

M QAD Questions? Visit community.gad.com


http://community.qad.com

Navigating the QAD .NET Ul 21

Benefits

Chapter Benefits

« You willbe able 1o navigate the different
types of screens and programs within
Enterprise Applications

Comments? Go to goo.gl/MfwKHm MNQAD


http://goo.gl/MfwKHm
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Training Flow

Training Flow

* Introduction

- Navigation

» Application Help
- Programs

- Browses

» Character Ul

- Dashboards

M QAD Questions? Visit community.gad.com
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Overview of Ul Navigation Features

Ul Navigation Features

Main menu bar

@ Applications =
e Menu search for programs,
#13 Callections browses, and other menu tems

# 7y Metrics
+ {3 Customer Management

File Edit Tools Workspace Window Help

#-(3 Supply Chain 3 ,

5 Momfochuring o «— Applications Ared
% = Financials

&3 Master Data

#1075 System Administration

+ 7 Frocesses

# () Administration

047 Hide and View MNavigation Pane

¥ Fovorios o «——— Fovorites Areg
B Browse Collection Mainwnance
%5 Menu Collection Maintenance

+ |5 Process Sales Orders

[ Quick Search o
= Messages o
o N

2

inbox
Sant
Drafs.

Quick Search Ared

Messages Inbox

mig -

The QAD .NET User Interface (Ul) provides a common framework for multiple QAD
applications. This framework, based on Microsoft .NET technology, has excellent performance
and provides best-practice usability and deployment features, as well as extensive ways for users
to adapt the Ul to their preferred work style.

When you first log into the .NET Ul, you see a screen like the one above.

1 The main menu bar includes selections for File, Edit, Tools, Workspace, Window, and Help.
2 The menu search helps you locate programs to run.

3 The Application area displays the application programs that can be run in the QAD .NET UI.

4 Use the dashed bar to close and open the navigation pane. Closing the pane gives you more
area to work in.

5 The Favorites area can be customized by each user to list frequently used programs.

6 The Quick Search area lets you search for a value across all of the fields in a browse group,
which are definable by each user (see “Quick Search” on page 103 for details).

7 The Messages inbox displays messages generated through the QAD Enterprise Applications
internal mail system.

Each distinct area of the Ul can be resized to suit your needs by dragging the edge to the place you
want.

Comments? Go to goo.gl/MfwKHm MNQAD
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Workspace

Workspace
File Edit Iool{ W[ Window Help

& Applications TSA Division [USD] > 10CORPCONS USA CORP. CONSOLIDATION
1] 10USA\JISA Division [USD] > 10USACO USA DIVISION
%711 Sales Od 11CAN Cynada Division [CAD] > 11CANCO CANADA DIVISION
E7in Sales Or 11CAN Cartada Division [CAD] > 11NACONS N.AMERICA CONSOLIDATION
[=EARY] Sales Or A
%7113 Sales OF 12MEX Mexicly Division [MXN] > 12MEXCO MEXICO DIVISION
(@714 SalesO | 20FRA France Djvision [EUR] > 20FRACO FRANCE DIVISION
37115 Sales Or i
=711 Sales O 21NL Netherlanda Division [EUR] > 21ITCO ITALIAN DIVISION
= ARV SslesOf  21NL Netherlands Division [EUR] > 2 INLCO NETHERLANDS DIVISION
ey ;1 :g ; m 22UK United Kingdom\Division [GBP] > 22EMEACONS EMEA CONSOLIDATION
L?jj7:1 ]9:2 ATP Erfl 22UK United Kingdom Division [GBP] > 22UKCO UK DIVISION
. 30CHN China Division [ > 30CHNCO CHINA DIVISION
31AUS Australia Division [AUDP] > 31APCONS ASIA-PAC CONSOLIDATION

1 iz Set Up General o
+ 1.2 Containerize Sal | 31AUS Australia Division [AUD),> 31AUSCO AUSTRALIA DIVISION
# luz| Process Sales O QAD System Domain [USD] > 99¢ - SYSADM

€ Verical Industry} ) 1) puerto Rico - Demo [USD] > Entity € SSM Training Entity
F Quick Search Train Puerto Rico - Demo [USD] > Trajning Entity For Training

1 Favorites

Starts With v | B

# ¢ Customer Data
Click to select a workspace
from the menu or the
workspace selector toolbar

essages oo -
OUSE USA Division [US0) CANCanada Division [CAD] | - T1CAN Canada Division [CAD) MEX, Mexico Division (MM
R X 8] DA D

In the .NET UI, your application context is determined by a combination of domain and entity,
called a workspace. Workspaces represent the area of your business where you are working. In this
class, you are using the 10USA > 10USACO workspace, which represents the 10USA domain and
the 10USACO entity.

Most users only use one workspace and once selected, it is always active by default. When you
exit the QAD NET UlI, the active workspace is saved and displays when you log in again.

If needed—and you have the necessary access—you can select a different workspace that displays
on the Workspace menu. The check mark signifies the domain that is currently active.

If you need to change workspaces regularly, you can also enable the workspace toolbar, shown
above. Clicking a workspace name in the toolbar changes the current domain and entity. The
toolbar is enabled using the Show Workspace Selector option on the Tools|Options menu.

For more information on the domain and entity concepts, see QAD QuickStart Training Guide.

M QAD Questions? Visit community.gad.com
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Ul Navigation: Process Maps

Ul Navigation: Process Maps

+ Link multiple actions to a single node
& +Link to any document type
e i « Navigate to dppropriate functionality
b i wzo-|  +Standardize training
B2 B & @) @ | ~Reduce errors
[ v- . » i | & | +Deploy globally in multiple languages

Process Sales Orders

Enter Sales Run Credit Update Sales
Order Report Order Credit

Aceounting Sup o L Mga‘; L SRl B
¥ l *
Farteting falaOmer - Qrienon Credt . ey BT Suppler
Instructions Rt EHE S0 fo o

The .NET Ul provides many ways to navigate and find programs you are interested in. You can
select programs from the menu on the left or enter a program name or number the search field.
These methods are shown in following slides.

This slide shows a top-level view of the process maps supplied with the .NET UI. These maps are
graphic representations of workflows that can include links to programs, browses, documentation,
URLSs, or other maps.

The .NET Ul includes a Process Editor so that administrators can create their own maps that
accommodate unique company standards. Users can edit process maps for any segment of the
organization, or model unique environments in as much detail as appropriate.

The set of process maps supplied with the product has been carefully designed to incorporate best
practice workflows tailored for various vertical industries.

Using process maps can:

« Improve end user performance by making process instructions visual and readily available,
increasing awareness of standard procedures for routine and special tasks.

« Reduce errors and waste since users quickly access information regarding handling
procedures, detailed documentation and instructions, eliminating guesswork.

« Increase global staff communication through maps that are globally available and editable to
match regional language and operational demands.

Comments? Go to goo.gl/MfwKHm MNQAD
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Drill-Down and Breadcrumbs

Drill-Down and Breadcrumbs

Supply Chain Process Model » Select Global Suppliers » Schedule Purchase Orders

Schedule Purchase Orders

Planning and

Scheduling Purchasing

Supplier

sehedu ien |

e

Processes are built with two basic components:
- Nodes are represented by various shapes and typically indicate a step within the process.

- Connectors are lines with arrows that indicate the direction of execution for the steps (nodes)
within the process.

You navigate the process map using nodes, and can retrace your steps using the hyperlinked
breadcrumbs at the top of the screen.

M QAD Questions? Visit community.gad.com
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Ul Navigation: Applications Area

Ul Navigation: Applications Area

File Edit Tools Workspace Windd > = =
- = - - File Edit Tools Workspace Window Help

‘@} Applications -
3 @ Applications
f _ Enter menuname or —  ~
# (5 Collections number to open e
BT Metrics #15) Collections
#H5 Customer Management . ; Mekics
Click folder or + icon — =% Customer Management

T Supply Chain e .
T Manufacturing TO Opeﬁ =) ...* E'ia\es Orders/Invoices
[FH5 Financials =EEY falﬁ Drnu
e e Sales —
FHT Master Data ) & i

F{T System Administration Double click QMY —» [ ::35 gl':e" E@:’Sﬁ
oo RIASIATR RSN Do e i
T Administration =

- 28| Sales Order Confirmation

@ Sales Order Manual Allocations

.7 Favorites
#{E| Set Up General Ledger
Containerize Sales Order Shipments
3 Process Sales Orders

£ Vertical Industry View
{E| My Collection
I5] New Folder

F Favorites
Set Up General Ledger
| Containerize Sales Order Shipments
[ |ué| Process Sales Orders
£ Vertical Industry View
(5] My Collection
{5 New Folder

&

The Applications area displays the menu items for the QAD applications running in the
QAD .NET UI. When the system is installed, the default menu organization is automatically
loaded. Multiple screens can be open at any one time.

You can use the mouse to select menu items. You can use the menu search to:

 Find programs based on one or more menu label keywords, program name, or menu number.
For example, enter sales to display all menu labels that include the word sales.

« Execute a specific program based on full menu label, program name, or menu number. For
example, enter Item Master Maintenance, ppptmt.p, or 1.4.1 and then press Enter to display
Item Master Maintenance.

« Execute a specific program based on a shortcut defined in the Name field of Menu System
Maintenance (36.4.4.1 in EE, 36.4.4 in SE).

When typing in the menu search area, different screens appear as the typing continues until the
proper screen is located. This is called predictive text.
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Menu Properties

Menvu Properties
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4

You can view the information about a menu item by right-clicking it and choosing Properties from
the pull-down menu. The Properties window includes two tabs: General and Program.
The other options on the right-click menu let you:

 Find the program in the menu system, so you can see its hierarchical position relative to other
programs.

Note The Find in Menu option changes to Collapse Menu when the hierarchy is already
displayed.

» Add the program to the Favorites area (you can also do this by dragging).
» Open the program in the workspace so you can use it.

= Design a custom version of the program. This option is disabled unless you belong to a special
group of users with access to the Configurable Screens feature. Configuring custom program
screens is an administrative function that is covered in Training Guide: QAD .NET Ul
Administration.
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Properties Options

% Sales Order Maintenance Properties

eral || Program |

Sales Order Maintenance

gadsh:/menufinvoke?menu-key=A 1&menuitem-key=7.1.1
711
;711 sosomtp

= Customer Managsment
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%, Sales Order Maintenance Properties

General | Program |

Domain:
Program:

Ul Template:
Desktop Version:

Version:

Open with:

USA Division (USD)

sosomip

2.10.85.130

QAD Enterprise Applications 2012 - Enterprise Edition_

Desktop -

Cancel ] [ Apply ]

The General tab displays:
URL. The QAD Shell URL for the program.

Key. The program number; 7.1.1 is the program number for Sales Order Maintenance.

Aliases. The program number and name. For example, for Sales Order Maintenance, 7.1.1 is
the program number and sosomt.p is the program name.

Menu. The menu item folder location.
The Program tab displays:

Domain. The current working domain and domain currency. If the specific program updates
data that applies to all domains, All Domains displays.

Program. The program name. For example, sosomt.p is the program name for Sales Order
Maintenance.

Ul Template. If the user executing the program has been assigned a Configurable Screens
version of the program, the name of the assigned Ul template displays. The configurable
screens feature is discussed in Training Guide: .NET Ul Administration.

Desktop Version. Version details for the .NET UL.

Version. Product system version details.
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Properties Options: Open With
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Open with. Determines how the program will display in the workspace. Possible values are:

Desktop: The mode normally used by non-component programs in the .NET Ul, which
supports all of the enhanced navigation features.

.NET User Interface: This mode is supported by only a few programs that have been rewritten
using a client-side plug-in that supports additional navigation features such as drag and drop.

Browse Viewer: This is the normal mode for browses that displays data in an interactive grid
or chart format.

Terminal: This mode is a simple representation of a character-based screen.

You can change the Open with property from Desktop or Browse Viewer to Terminal according to
your preference. If you do so, your choice will be retained from session to session.

Note You cannot change the Open with setting for component-based programs.

This slide shows Sales Order Maintenance as it displays in the QAD .NET Ul (Desktop mode) and
the more traditional Terminal version of the screen below. In Desktop mode, you can use point and
click, tab, Next, Back or Header, Lines, and Trailer Tab to navigate.
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Favorites

Favorites
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The .NET Ul lets you customize the interface in many ways to make your work easier. One way to
do this is to set up your own personal favorites menu. You can do this in two ways:

« Right-click a program in the top list and select Add to Favorites.

« Use your mouse to drag the program to the area below. This makes a copy of the menu item;
you can still find it in the list above as well.

Remove an item from the favorites using the same steps: either right-click and select Remove or
drag out of the Favorites.

You can rename programs in your favorites so they are even more personalized. In addition, you
can create folders and subfolders for organizing favorites by right-clicking in the Favorites area.

Two other options let you further manage favorites. You can:

- Select one or more items to start automatically when you log in using the Auto Start option. So
if, for example, you typically log into the system to approve requisitions, you can have the
Purchase Requisition Approval program start automatically every time you log in. Items
selected for Auto Start display in bold text in the menu.

» You can change the icon associated with a program by loading the image you want to use.

One other useful feature for favorites is that you can add external files by simply dragging and
dropping them into the favorites area. This slide shows a Microsoft Word file with work
instructions added as a favorite.
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Workspace Menus

Workspace Menus

- File Menu
Edit Menu
Tools Menu
Window Menu
Help Menu

The menus on the menu bar of the .NET Ul workspace provide many useful options, discussed
next.
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File Menu

File Menu

File  Edit Tools ‘Workspace ‘Window Help
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Exit

The File menu commands include:

Logoff/Login. Log off from all applications running in the QAD NET UI. You can log in as a
different user if security allows.

Page Setup. Defines print output for browses; this has no impact on maintenance programs.
Print Preview. Generates a print preview of a browse prior to print.

Print. Open the print dialog so that you can print the data for a browse or the screen for other
programs.

Program History. The section below Print displays the last six programs that you have opened.
You can choose to open one of these programs directly from this pull-down menu.

Exit. Close the QAD .NET Ul and log off any open applications.
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Edit Menu

Edit Menu
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The Edit menu commands include:

Cut, Copy, and Paste. These are standard Microsoft commands. View associated shortcuts on
the screen above.

Menu Search. While in any screen you can immediately go to menu search by using the
shortcut Ctrl+M or select Menu Search from the Edit menu.
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Tools Menu

Tools Menu
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The Tools menu commands include:

Options. View administrative information and set personal options for browses and other
application settings. For more information, see next slide. Settings the user cannot configure
are viewable from Help| View Configuration.

Internet Properties. Update the same settings that display when you select Internet Options
from the Tools menu in Internet Explorer.

Delete History. Delete the following data:

- Temporary files: Internet Explorer cache and IE cookies and cached resources created for
the current configuration.

« Session information: the graphical state stored by the GUI persistence manager. Also
deletes user input, such as last configuration, last workspace, most recently used menu
items, and credentials.

Manage Workspaces. Activate and deactivate workspaces from a list and reorder them.
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Tools | Options

Tools | Options
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Cell Font Microsoft Sans Serif, §.25pt
Message Color M slack
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El General
Allow Multiple Applications True E|
f Left Navigation Panel Style Studio Toolbox -
Allow Multiple Applications
If this value is set to true, then multiple instances of the application can be launched.
&

QAD .NET UI lets each user configure many different settings that affect the Ul in these areas:

Browse. Configure settings for Cancel transaction on drill change, Cell Font, Link Font Color,
Row Alternating Color, Row Background Color, Rows Per Page, Side Panel Auto Open.

Desktop. Configure settings for Auto advance on next data field, Cell Font, Prompt user on
open transaction, Screen Navigation Bar, Text Report Font, Ul Extensions.

General. Configure settings for Allow Multiple Applications, Left Navigation Panel Style,
Show Workspace Selector.

Guide Me. Enabled.
Home Page. Enable Home Page, Home Page URL.

Messaging. Configure settings for Auto Complete Recipients Textbox, Display Alerts, Empty
Deleted Folder Frequency, Poller Frequency.

Metrics. Image, Title.

Terminal. Background Color, Bold Color, Font, Foreground Color.
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Window Menu

Window Menu
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This menu displays a history list of programs in the order in which they were opened. Selecting
Close All Windows shuts all screens on the workspace.
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Help Menu

Help Menu
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Use the Help menu to display Application and Program Help, and to view installation and
application configuration details. Help is discussed in more detail in Chapter 3, “Help in the
QAD .NET Ul,” on page 47.

The Help menu commands include:
Search. This option displays the default search page.

Application Help. This option is available when your cursor is placed within a non-component
based field or screen. When you then select Application Help, field or procedure help is
displayed for the field or screen.

View Configuration. Opens a window that displays various configuration settings that cannot
be directly changed by a user of the QAD .NET UI. These settings must be changed by a
system administrator.

Send Error Report. Use this option to save or send an error report. You can view the report,
which includes QAD .NET Ul configuration information and log files and enter additional
information about what you were doing when the problem happened. Optionally, you can
enter your e-mail address and send a screen shot and either Send or Save.

About. Displays information about the version of QAD .NET Ul that is running, the time the
QAD .NET Ul was started, and the total amount of physical memory the QAD .NET Ul is
using. (If N/A is displayed, the operating system is not giving the QAD .NET Ul permission to
access system information.)
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Component and Non-Component Based Programs
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Only Enterprise Edition Financials and some System Administration programs are component-
based. All other applications are non-component based, including Standard Edition Financials.
Component-based programs have individual maintenance programs, such as Create, Modify, and
Delete.

Chapter 4, “Programs in the QAD .NET Ul,” on page 59 provides details about using programs.
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Navigating Component-Based Screens

Navigating Component-Based Screens
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Because the component-based Ul is based on Microsoft .NET technology, it incorporates familiar
mouse, click and drag, and tabbing functions.
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Horizontal and Vertical Tab Groups

Horizontal and Vertical Tab Groups
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You can choose two ways of viewing multiple screens in the application area. This works
especially well with the QAD .NET Ul browse programs.

This slide shows the Process Sales Order menu collection, which groups all of the programs that
you might need to use to complete activities related to an order. The grouping is facilitated by
defining tab groups. Right-clicking the Process Sales Order tab displays the menu in this slide.

Tab groupings help you organize open programs in either horizontal or vertical layout.

« Click New Horizontal Tab Group to split the screen horizontally and move this program to the
new area.

 Click New Vertical Tab Group to split the screen vertically and move this program to the new
vertical area.

You can only use horizontal or vertical groups, not both. But you can create as many of one type of
group as you want.

You can also detach a tab from the application area and display it in a new window. Right-click the
tab and choose Move Tab to New Window or enter Ctrl+F11. To move a tab in a separate window
back to a tab in the application area, enter Ctrl+F11.
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Navigating Non-Component Based Programs

Navigating Non-Component Based Programs
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Because non-component based screens are a rendering of the character Ul, you can navigate these
screens using the same keyboard commands. You can also use mouse clicks to select fields and
enter data.

When some programs open in Desktop mode, a navigation bar is displayed along the top of the
screen indicating where you are as you proceed through the program screens. Not all programs
have this bar; it is typically used with complex transactions such as order creation.

For example, the screen for Sales Order Maintenance includes a navigation bar indicating the parts
of a sales order: Header, Lines, Trailer. Within each major section, you can navigate using the bar
to specific subareas. When you are displaying the header of a sales order, you can navigate directly
to Details, Tax Info, Freight Info, Salesperson, Delivery, Consignment, or Comments by clicking
the label in the navigation bar.

The Screen Navigation Bar option in the Desktop section of the Options menu (choose Tools|
Options) controls whether your QAD .NET Ul client displays the navigation tool.
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Sales Order Maintenance

Navigating Lookup Browses

® GoTo ~ Actions »| L1l Copy =| =0 Print (& Preview | & attach
Sales Order: (> Order
Header Lines
> Header > [0 [ 2 f b= [ 2 B [ [ 1 ¢ B
Header
Oider; Sold-Ta: Bill Te: Ship-Ta:
————
| WSales Order Master
Sold-To - = ”
x Actions = U= Print
earch
[5ales Drder - | [starte at - Pla] -
Records per page: 100 - ®» @
Sales Order A% SoldTe &% OrderDate & % Purchase Order
[l 10005 CE4000 0&/21 /2007
tyakalis 10006 CE4D00 06/21/2007
Orclat Date: 10009 CE4000 08/21/2007
. 10012 CE3000 0E/21/2007
Flequired Date:
Bromise D 10013 ce3000 OE/21/2007
e 10016 CE3000 06/21/2007
Dug Data: 10019 CEA000 06/21/2007
Perform D ate: 10025 CE 2000 R{22420017

Many fields display a small magnifying glass icon on the right of the input area. This indicates that
a lookup is associated with the field. Click the icon or use the Alt+L keyboard shortcut to display
the lookup. The lookup lists valid values for the field.

A drop-down list is displayed when only a few values apply to a field.

Browses on the menu, called power browses, include more complex navigation features. Browses
are discussed in more detail in Chapter 5, “Browses in the QAD .NET Ul,” on page 81.

Comments? Go to goo.gl/MfwKHm

MNQAD


http://goo.gl/MfwKHm

44 Training Guide — QAD .NET Ul

Summary

Summary

« NET Ul has many alternate ways of
navigating

« You can choose the mode of display for a
program

Differences exist between component-
based and non-component based
programs
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Exercise and Knowledge Check

These exercises and discussion questions will help you become familiar with navigating the user
interface.

1 Using each of the Process maps (Vertical Industry, End-to-End, and Supply Chain), drill down
until you can create a sales order. Which view seemed easiest to you?

2 Create a custom menu by:
a Right-clicking a menu item and selecting Add to Favorites.
b Drag several menu items into the Favorites section of the UI.

3 Open the following four programs:
- Sales Order Maintenance
« Sales Order Shipments
- Sales Order Browse
« Sales Order Credit Browse

Right-click on Sales Order Browse and create a new tab group. Add Sales Order Credit
Browse to the tab group with the other browse. Can you see how this arrangement could help
you when processing a sales order?

Right-click on Sales Order Browse again and select Close All.
4 Change the way a program displays:

a Select Customer Data Maintenance from the menu.

b Right-click and select Properties.

¢ Onthe General tab, note the menu number associated with this program. What is this field
labeled?

d Click the Program tab and change Display with to Terminal. Click OK.
e Type the menu number (2.1.1) in the search and press Enter.

f  Compare the two program displays by selecting a customer record and moving through the
frames. How is this Ul different than the normal Desktop mode?
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Objective

Objective

Learn about the extensive help capabilities
of the QAD .NET Ul:

- Character Ul Help

- Application Help (F1 or Help | Application Help)
- QAD Search (Help | Search)

- QAD Guide Me

- QAD Document Library
http://documentlibrary.qad.com/
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Benefits

Benefits

Become aware of the different types of help
and how they can be accessed

Be able to choose the most appropriate
help source

Comments? Go to goo.gl/MfwKHm MNQAD


http://goo.gl/MfwKHm
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Training Flow

Training Flow

« Introduction

+ Navigation

- Application Help
- Programs

- Browses

« Character Ul

- Dashboards

M QAD Questions? Visit community.gad.com


http://community.qad.com
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Help in Terminal Mode

Help in Terminal Mode

Purchaie Quder Maintenance % (

| Purchase Order: Supplier: Ship-To: I

Purchase Order Masntenance X
Supplier —— gy [ Fio1d Felp : Purchase Order S

Pur Enter a number identifying an order or leave blank for
system-generated number. If blank, the system creates

Purchase Order iyl

h | number baged on the purchase order prefix and next pur
Furichaas Orcec order number maintained in Purchasing Control.
12 The system displays a warning if:
Order Date: 20010601
Bue Datet Ak 1 o You enter a purchase order that has already been p
BI?;Y:I- acmioo 1f you modify the order, it may no longer correspos
ll 7 g' isc the one sent to the supplier. You can update the r
e it o number to track additional changes.
Contract:
Contaet: 0 The order you specify was created in Scheduled Ord
Remarks:

Maintenance. Since different data is maintained fo
scheduled orders, you should normally maintain thes
their own program.

Enter data or press F4 to end.

Enter data or press F4 to end.

Access help in terminal mode by pressing F2.

« The first time you press F2, a lookup browse displays if one is attached. If not, field help
displays first. Use lookup browses to view records available to specified fields. You can
choose a record to enter in the field. If you enter a value and press Enter, the list in the bottom
of the browse frame scrolls to the first record that matches that value. Use the arrow keys to
scroll through the list, then select the record by pressing Enter.

» Press F2 again to display field help. It describes a specific field and how it is used in the
program. Most updateable fields have field help. Display-only fields do not.

» Press F2 again to display procedure help. It describes the program and how it is used in the
module. Procedure help is not generally provided for reports, inquiries, browses, or control
programs.

Comments? Go to goo.gl/MfwKHm MNQAD
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Help Menu

Help Menu

File Edit Tools Workspace Window |Help

e [&/—« search j
@Appllcatlons & JP’DD,, N AR | X

Application Hel
] . @ Application Help

‘g,: Print ] Preview
View Configuration

Heade

51 Customer Management P He M” >

{5 Supply Chain About
Aec=chxing Order:| D[ sold-To
[+ Financials .
[#{5) Master Data
[#-{5] System Administration Sold-Te
Processes

] Administration
-5 Tools

Options on the Help menu include:

Search displays a panel where you can search field or program help or both using terms and
operators.

Application Help is available when your cursor is in a field. Choosing it displays the relevant
field or program help. You can display the same information by pressing the F1 key.

View Configuration opens a window that displays various configuration settings that cannot
be directly changed. This information can by useful for system diagnostics.

Send Error Report lets you save or send an error report that includes QAD .NET Ul
configuration information and log files. You can enter additional information about what you
were doing when the problem happened. Optionally, you can enter your e-mail address and
send a screen shot.

About displays information about the version of QAD .NET Ul that is running, the time the
session was started, and the total amount of physical memory being used.

M QAD Questions? Visit community.gad.com


http://community.qad.com
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Application Help (F1) for Programs and Fields

Application Help (F1) for Programs and Fields

QOR2D D
" BIournalEntry.Create |' Field Help | =
Journal Entry Create Al
Use Journal Entry Create (25.13.1.1) to manually record transactions for financial daybooks.
However,. "
e : ol
A journal entry, or postin @ Help g@

representation, a journal (| 5y 5y ® -'n "-5'# s
associated with a GL accoll — —
have other dimensions, re

r.. Sales Order Maintenance | Field Help \|

Define the transaction po{| | 53les Order | Sales Order
levels containing addition|| g0 gb-account . ber identifyi 3 | S

: nter a number identifying an order or leave blank for a system-

The level 1 posting line cq  Salesperson generated number. If blank, the system creates a number based on the

description, base currency|  Selected sales order prefix and next sales order number maintained in Sales Order
; ; Ship Via Control.
The posting grid can auto| !p i
on how the GL accounts 4| ShiP-To
Site (so_site)
o Transaction currency Site (sod_site)
[<] Sold-To
Sort Name
Standard Bill =]

Standard Pack
Quantity
{ord_mult_alt)

Srandard Dark Inel

The number uniquely identifies a specific order or pending invoice and its
line items.

QAD Document Library | Support

When your cursor is in a program field, you can press F1 or choose Help | Application Help to
display online help. Help is organized into two tabs:

 The Field Help tab displays a list of fields associated with the current program. Help for the
field where you cursor is located initially displays in the help panel.

» The other tab displays the name of the program and the associated help information.

At the bottom of the help panel, you can access links to the QAD Document Library or to QAD
Support, which includes an extensive knowledgebase.

Comments? Go to goo.gl/MfwKHm MNQAD
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QAD Guide Me

QAD Guide Me

‘ Item Master Maintenance X

% GoTo - Actions - | L Copy -| (=) Print & Preview | # Attach -
ltem Planning Price
b Hem P ltemData B Inventory B ltem Shipping Data
ltem
Item Number:| | - '-‘_ Description:

Unit of Measure:

ltem Data
Prod Line: [tem Ty&: Drawing:
Ldded: <t; Enter an optional code used to categorize similar items.
This field is validated against predefined values entered in
Design Group: Gr Generalized Codes Maintenance for field pt_part type, if Size:
any. More...
Promo Group:
Edit
Item Imventory Data
ABC Class: Average Interval:
kliSesizl Conizol CualeCouatlntenal.

The QAD Guide Me feature provides immediate mouse-over descriptions of fields in both
component and non-component programs.

Note If this help does not display, it may be disabled. You can enable it using the Guide Me
setting found on the Tools|Options menu.

One useful feature of this help is that you do not need to locate your cursor in a field to see the
help. In the current example the help for Item Type is being displayed even though the active
context field is Item Number.

Click the More... link to display an extended description of the field, and the Edit link to edit this
description in Field Help Maintenance.

Note The Edit option displays only if your role gives you access to this program.

M QAD Questions? Visit community.gad.com


http://community.qad.com

QAD Search
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Search

programs,
fields, or both

Use achvanced
search operators
and fuzzy
matches

QAD Search

Pragram Help | Field Help | Al

Customer AND Create

Customer Payment Create [BDDocument.Create]
Use Customer Payment Create (27.6.4.1) to create customer payments,

Customer Ship-To Create [BDebtorShipTo.Create]
Use Customer Ship-To Create (27.20.2.1) to create customer ship-to records,

Customer Create [BDebtor.Create]
Use Customer Create {(27.20.1.1) to set up customer records in the system.

Customer Type Create [BDebtorType.Create]

Usge Customer Type Create (27.20.4.1) to create codes for grouping customers. You can use
customer type to select groups of customers for reporting, in particular for sales analysis
reports. Customer types are system-wide data and apply to all domains and entities.

Customer Invoice Create [BDInvoice.Create]

Use Customer Invoice Create (27.1.1.1) to directly create invoices for miscellaneous customer
charges or credit notes. For this type of manual invoice, you must specify most of the fields
that are automatically populated during invoice post.

Choose Help | Search to display the QAD Search panel. You can do simple searches for single
terms such as Sales and phrases such as Sales Orders. You can also create more complex terms
using operators such as Sales AND Region. You can use any of the following operators (entered in

upper case):

AND, +, OR, NOT, -

If you are unsure of the exact term you are searching for, use wild cards:
» Use a question mark (?) to replace a single character; for example, S?les
» Use an asterisk (*) to replace multiple characters; for example S**es

« Use the tilde symbol (~) to perform fuzzy searches, which return results similar to the term
you entered. You can specify the similarity to the searched term using a numerical option
between 0 and 1 for example, sales~0.8. The closer the value to 1, the greater the similarity.

The default value is 0.5.

« Use numerals to specify words within a specified distance from each other. For example, if
you enter Sales Region~10, the panel displays all instances of Sales and Region that appear
within 10 words of each other in a document.

Comments? Go to goo.gl/MfwKHm

MNQAD
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QAD Document Library

QAD Document Library

SOLUTIONS INDUSTRIES SERVICES SUPPORT ABout | (2]

Document Library

rodust Suite Shewing 1-20 of 3 583 Sony: | RelEne el ToeAZ
Use three

nenagation ; .

OpTiOﬁS to el ality Systoms Guitla fweh book)

P st QA “atmation Management 7.3 User Guide fwob hoak)

ook k3 aan - SsrneTm s st g Slides (2ip)

Product Moduie o Search ocross - Help seeviaeo)
:Ir L r[ 5 o dOCUm ehTQﬂOh S LR Select P de M 10 Use our wizard

Filters hel o . ak izl ning Gulde Slides (.21)
yOU fiia ﬁ it OAD Product Structures and Formulas 2011.1 EE Training Guide Slidus {.rip) alaie Tor s arakiin of cu setuire.
YOoulr QAD Co/fly Product Costing 2012.1 EE Training Guide Stides {.rip) Select Search Web Books 10 search for
sedrch

OAD Product Costing 70111 EE Tralning Guide Stides {zip)

0AD Co/By Product Costing 2013.1 EE 1

Click to view a
video tutorial

QAD Product Changs Contral 2012.1 EE

Module Version QAD Product Sirictures and Formulas

QAD Product Change Contral 2013.1 EE Training Guide Sfides (.£1p)

2005

+ http://documentlibrary.qad.com/
* Alink to a video tutorial is available from the Help section

Access the QAD Document Library by clicking the link at the bottom of the application help or
search panel. The library includes user guides, administration guides, installation guides, training
guides, and other materials, including PowerPoint training slides.

You can also access this library directly from your browser:
http://documentlibrary.gad.com

From the Document Library, you can:

« Use the Search, which finds all documents with your search terms and lets you refine the
search based on such criteria as product suite, module, version, and so on.

 Use three tabbed navigation modes—Guide Me, Downloads, and Search Web Books—to filter
and search for the book you want.

A link to a video tutorial is available from the Help section of the Document Library.

M QAD Questions? Visit community.gad.com


http://documentlibrary.qad.com
http://community.qad.com
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Summary

Chapter Summary

Help includes the following features:

Character Ul Help

- Application Help (F1)

QAD Guide Me
QAD Search

QAD Document Library
http://documentlibrary.gad.com/

Comments? Go to goo.gl/MfwKHm

MNQAD
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Exercise and Knowledge Check

1

Launch Purchase Order Maintenance in Terminal mode.

Note Use Properties, Open with to change the mode to Terminal if needed.

Press F2 in the first field of the purchase order. What is displayed? Press F2 again. What is
displayed this time?

Go to the Sales Order Maintenance screen and select Help | Search. What screen is displayed?
Do a search on the word Sales. Drill down on Sales analysis. What is displayed?

Go to Journal Entry Create and press F1. What is displayed? Note the differences between
non-component based help and component-based help.
Find out the answer to the following question by using one of the forms of online assistance:

When a sales order is created, a default value displays for Credit Terms. Where is this default
value set?

Which form of help did you use to find the answer? Why?

M QAD Questions? Visit community.gad.com


http://community.qad.com

Chapter 4

Programs in the QAD .NET Ul
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Objective

Chapter Objectives

« Describe program types and program
features in QAD Enterprise Applications
« Review program menus

+ Infroduce QAD Messaging

M QAD Questions? Visit community.gad.com


http://community.qad.com
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Benefits

Benefits

|dentify different program types
Understand how to use program menus
Use QAD Messaging effectively

Comments? Go to goo.gl/MfwKHm MNQAD
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Training Flow

Training Flow

« Introduction

+ Navigation

+ Application Help
- Programs

+ Browses

« Character Ul

« Dashboards

M QAD Questions? Visit community.gad.com


http://community.qad.com
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.NET Ul Program Types

oNET UI Program Types File Edit Tools Workspace Window Help

@ Applications

5 (=) Collections [
47 Metrics
=14 ™ Customer Management
=1L Sales Orders/Invoices |
=\ "% Sales Order Menu ‘
% Sales Order Maintenance
Browse @ - > [ Sales Order Browse
= [@ Sales Order Print
; i =] Sales Order Viewer
Transaction or WHility ‘: | = E:Sales Szl
|=| Sales Order Manual Allocations
. |=] Sales Order Auto Allocations
Report or Inguiry __é____, [@ Available Kit Quantity to Ship
|=| Sales Order Repricing

; |Z) Sales Order Cost Revaluation
Maintenance Prog i —%*#" % Sales Order Credit Maintenance

) Sales Order Credit Inquiry

[ Seles Order Credit Report E

¥ Favorites

Menu Collection —{§8) —»| ® (@ SetUp General Ledger
# {=| Containerize Sales Order Shipments

# & Process Sales Orders
Frocess Map _ﬁr%%_. £ Vertical Industry View
= i My Collection
% Ssles Order Maintenance
[ Sales Order Browse

On the menu, a distinct icon indicates the type of program:
» Maintenance programs
- Transactions and utilities

Reports and inquiries

Browses and browse collections
Menu collections
Process maps

Each type of program maintains a specific kind of data within the database.

The next slides illustrate the types of programs that you will encounter as you use the product
during this course.

Comments? Go to goo.gl/MfwKHm MNQAD
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Maintenance Programs

Maintenance Programs

Non-Component Based

ftem Master Maintenance | I

W GoTo ~ Actions | .| Copy ~| @,ﬁ Print »| Preview | §’ Aftach
Preduct Line: (1) @ UIG-6163: (1) @ Item Mumber: (2)
I I Prwe—— Component- Base
P Mem P [=mDzz P ) == N . - -
i | go To ™ Actions = 4 Tools = & Attach | @‘ Frint 4 Preview
2 Attachments
[tem Mumber:
Unit of Measure: GL Account Il
D escription | @ i
ltem Data GL Type |7Standard Account - Suztermn Type |
Prod Line: Active v Eudget Group |7 ,7/"‘)
Status: Budget Enabled V| Category |‘_AS§"
Design Group:
Added: Posting | Currency " Analysis "Hepurt LinK" Sankin " azk "Defaults
Ve lovanton: Date
(B4 oount | Debit/Credi | Debit EA
Auto/Marual | Manual -
Intercampany Accaunt |
Fired Intercompany

Maintenance programs create and maintain basic codes such as customers, inventory items, GL
accounts, currencies, and other data. They are also used to record data that initializes business
activity in a module such as sales orders and purchase orders. Most maintenance programs update
static data, which is changed infrequently.

Entering data in a maintenance program creates a record in one or more tables controlled by the
maintenance program. For example, item records are stored in the Item Master table controlled by
Item Master Maintenance.

With non-component maintenance programs, all changes to the record are made in the same
maintenance program. In component-based maintenance programs, changes are made in separate
Create, Modify, or Delete functions.

M QAD Questions? Visit community.gad.com
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Inquiry and Report Programs

Inquiry and Report Programs

ltern kaster Inguiry - 572452010, V\| I
n Item Master Inquiry 05x24/i
QAD Itern Cost Report |Item Cost Report - /2472010 1. %
Site Description Line Description
Ttem Number: 01C RESh
Site: 10-19-100 Ultrasound Mfg Site 10 Finished Goods
7 01010 EA Medical Ultrasound
Prod Line: 1C
. Added: 01 Cost Set Material Labor Burden Overhead
Design Group: PR
Promo Group: ME
Current 225.71 19.34 0.28333 0.00
13/01/10
ABC Clas Standard 225.71 19.34 0.28333 0.00
Lot/Serial Controys o110
59t
Locatic 01011 EA Supplies Kit
Location Ty
Auto Lot Number Cost Set Material Labor Burden Owverhead
Lot Grou
Article Numbe
Current .00 0.00 .00 0.00
13,/01/10
Corp Comm ot Standard .00 0.00 .00 0.00
Ship Weigh3m1/10
Freight Clas
01020 EA Implantable Ultrasound
Cost Set Material Labor Burden Owverhead
Current 144.815186 25.09176 0.36372 2.00
13,01/10
Standard 144.815186 25.09176 0.36372 2.00
13,01/10

Inquiries and reports retrieve and display database records.

« Inquiries are primarily used to answer specific questions and are typically viewed online,

although they can be printed

* Reports usually provide more detail and are printed for a range of data records. You select data
by entering a specific range of criteria, such as item number or date. Reports are often sentto a

printer or file. Other output options such as e-mail are available.

Comments? Go to goo.gl/MfwKHm

MNQAD
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Component-Based Reports

GL Account List % |

< Tools | &b Print » Preview  Variant =

Repon Vaniants
Fiter

GL Account €%
05000 y,

FACTORYDEFAULT bt

Component-Based Reports

GL Account List

GL COA Element TySys Type DebitiCredt  Balance/PEL  Auto/Manual  Analysis Type
Account
05000 STAMNDARD DEBIT BALANCE MANLUAL Maone
05600 STAMDARD DEBIT BALANCE MANUIAL Maone
03610 SYSTEM RESULTCURRENTYEAR CREDIT BALANCE AUTOMATIC Maone
05620 SYSTEM RESULTPREVICUSYEAR CREDIT BALANCE AUTOMATIC Mane
09000 STAMDARD CREDIT BALANCE MARLAL Maone
09100 STAMDARD CREDIT BALANCE MARLAL Mone
10000 DEBTORCOMTROL DEEIT BALANCE AUTOMATIC Maone
10100 DEBTORDOCUMER DEBIT BALANCE AUTOMATIC Maone
10200 OPENMITEM DEBIT BALANCE MANLAL Maone
Server Output Processing 10300 DEBTORCONTROL DEBIT BALANCE AUTOMATIC Maone
10600 DEBTORDOCUMER DEBIT BALANCE AUTOMATIC Maone
11300 STAMDARD DEBIT BALANCE MAAMUAL Maone
12200 BAMNK DEBIT BALANCE MARNUAL Maone
12201 BANK DEBIT BALANCE MARLIAL Maone
13000 STANDARD DEBIT BALANCE MAANLIAL Maone

Component-based reports have multiple output options, including viewer, printer, and export to
PDF, XLS, and DOC standards. The report output is easy to customize, and you can create an

extensive set of reports with unlimited report variants for many output types.

You can run a report immediately, or choose to schedule it to run later. In this case, a pop-up
window opens to let you enter details for running the report at a later date.

MQAD

Questions? Visit community.gad.com
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Transaction Programs

Transaction Programs

Purchase Crder Returns NO“-Componeni Based I

W GoTo ™ Actions ~ | .|| Copy - Q.J Print s Preview | ﬁ Attach
Ordercall07 () Purchase Order:cal107 &) Ship-FromMD100

Purchase Order: call07 Supplier: dt100 Status Effective !. 5-2-‘#2010 v

RTV Nbr.| 1234 | taly Distsite
Journal Entry Create X Componeni' qued

Sh\p—FrDm:__MD]D[ # GoTo v fctions T 4 Tools 'I & Attach I I'.E,I Frint %] Preview
Ship—To::_dﬂDD Attachments

ear |ﬂ! ‘Ll Posting Date |W|

Davbaok Code | JE [ ][ ooooooom | Layer Type | OFFICIAL | save s Template

D escription | Joumal Entry ‘ Template Code | ¢ | Replacement

Original Posting [ | “Sequenca Murbe i—_DD_U_D_DD_U_D_D1 Reversal

B | Sequence Number = EE
GL Account 4 Sub-AccountC ¢ CostCe ¢ Description 4 Trans Curr 4 TC Debit L} TC Credit 4
1100 Expense uso 1,000.00 0.00

Expensze 000

Transactions express the core business activities of a company. They control and record activities
related to business documents such as sales orders and invoices. Example of transaction are
shipping a sales order or receipt of a shipment for a purchase order. Enterprise Financials
transaction programs include Customer and Supplier Invoice Create and Journal Entry.

Most data in the database is transaction data. Every day, sales orders come in, purchase orders go
out, and work orders make demands on and create material for inventory. These events result in
transactions, which are stored in transaction tables. In contrast to control programs, transaction
tables are constantly updated by users of the system.

Comments? Go to goo.gl/MfwKHm MNQAD
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Control Programs

Control Programs

‘Work Order Accounting Control X I

% GoTo ~ Actions = | Ll| Copy ~| 'E,J Print &) Preview
Post variances at SFCJ

Qty Complete Mihd; SUM 1 cussaoos

" | Work Order Contral X

¥ GoTo ~ Actions 7| .| Copy ~ 131 Print a Preview

Auto WO Numbers: ¥

Mext WO Nbr:| 1022
\work Order Comments:
Routing Comments:

Move First Operation: ¥

When you implement a module, you enter data that the system uses later to control the interactions
with users and with the database. This data is stored in control tables.

Control tables enable you to adapt QAD Enterprise Applications to your environment. The data
and settings in these tables determine how certain programs are displayed, the numbers assigned to
transactions, the GL accounts for particular transactions, and so on. When you can manage a
typical manufacturing function in more than one way, control settings enable you to establish a
preference.

This slide shows two control programs with settings that affect work order processing. To support
the enhanced segregation of duties features of QAD Enterprise Edition, financial control settings
are updated separately from operational controls. For example, Work Order Control (16.24) under
the Work Order menu in Manufacturing has only the operational control settings for work orders.
All of the financial control settings for work orders are in Work Order Accounting Control
(36.9.11) under the Operational Acct Controls menu in System Administration.

Note This is unlike QAD Standard Edition, where all control settings for a functional area are
updated in one program.

M QAD Questions? Visit community.gad.com
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Program Options

Program Options
Menu Optiong e x |

® GoTo ~ Actions = 7 Tools = & Attach '.,‘E;'..a Print ' Preview |
GoTo _ :
= Purchase Crder Returns x|
ACTIODS % GoTo * Actions *| .|| Copy ™ '& Print a| Preview y Attach

» Workflow (nhon-component programs)
Export Data (non-component programs)
+ Save and Browse Drafts (component programs)
Tools (component-programs only)
Workflow
Design
Toolbar Options
Copy (nhon-component programs)
Print and Print Preview
Attach

The menu options for browses are described in Chapter 5, “Browses in the QAD .NET UI,” on
page 81. This section describes key menu options on maintenance and transaction programs.
These options differ somewhat between component-based and non-component based programs.
Component-based programs have an Actions menu and a Tools menu; non-component based
programs have only the Actions menu.

This table summarizes differences in the program menus.

Non-Component Based Component Based
Go To links are added manually using User Tool Go To links are supplied automatically by the system based
Maintenance (36.4.8.5 in EE, 36.20.4 in SE). on the structure of the program. These include related views

and other options based on the field currently in focus. For
example, when GL Account is in focus, you can go directly
to creating a new budget group.

No Tools menu; Workflow option is on Actions menu. | Tools menu includes Workflow and Design Mode. Users

Design customizations is accessed directly through with access can modify the user interface appearance of the
menu-level programs and right-click menu option. program.
Simple workflow with link to program. More complex, structured, and predefined workflows.

Actions menu is mainly simple record-level actions. It | Actions menu is more complex and changes based on
includes an Export action that creates an XML file. specific program context. You can save and open draft
versions of a document.

Comments? Go to goo.gl/MfwKHm MNQAD
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Go To Menu

Go To Menu

Sales Order Maintenance * |

M GoTo ™ Actions = | L] Copy 7| E‘.:!';J Print 4] Pre
PO Maint ) ~ Order

Add Link
[ Header I [- I o B i [
Header

Order: | _-_.

- GL Account Create
& GoTo - Actions ¥ % Tools '! & ittach I L.E'..J Print  s] Preview
Related Views ]

»
Create Mew Budget Group

Create New GL Account Unit of Measure -

wL rpps |

Active v Budget Group
Budget Enabled

Non-Component Based Programs

The Go To menu for non-component based programs such as Sales Order Maintenance displays
the Add Link option. Use Add Link to create links to other programs using User Tool Maintenance
(36.4.8.5in EE, 36.20.4 in SE).

Component-Based Programs

The Go To option for component-based programs displays Go To options and Related Views.
Related Views are commonly used views and reports that apply to the record you are currently
working with.
Go To behaves differently depending on whether the current field has data in it:

- |f the field has a value, Go To invokes the View activity.

- If the field is blank, Go To invokes the Create activity.
All of the related views take the record you are currently using as the base for the information. You

can simply click the Go To to see the Create New Budget Group or Create New GL Account Unit
of Measure.

M QAD Questions? Visit community.gad.com
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Program Actions Menu

Program Actions Menu

J|Sa\es{)nﬁerI\-‘Iaintenam:e -’<| I

¥ GoTo v ActionsE;é_: Copy ~ \:5{, Print &) Preview | # Attach ~
Header Ling®p Next
P Header | ¥ Back

jhtDats P Szlesperson P Delivery P Consignment P Comments

Header Next Record . :
Customer Create *
Order: | Previous Record =
Ficat M GoTo ~ Actions »|%" Tools '; LE"J Print & Preview | # Attach +
Sald-To B Wordlow Undo Cirl+Z
E-mail Customef W Save Cirl+5 7] Betive 7
| CopylinkToCipboard  Business) 1 SweandCreate Gk |73 Bill-To Customer
Export Bote Save As Draft
Busine 1 Create Ctrl+N anking ” Defaults ” Credit Limit” Tax Info || Comments
' View Ctri+B -
Nam
& Modify Cirl+0 £
Add
Details ¥ Delete Cirl+D £
Credit Limit Maintain =
Properties... =
Zip! {
Exit Ale+F4 |
Cou
State |
County |
Telechans

The Actions menu lists active commands that apply to your current program context.

Non-Component Programs

For non-component based programs, Actions options include navigation commands such as Next,
Back, Next Record, and Previous Record. These commands let you navigate to the next or
previous frame, or display the next or previous record for the current field. You can also use the up
and down arrows on your keyboard to display next and previous records in key fields or when the
field has been defined to support next/previous processing.

For non-component programs, you can also choose workflow to send a link to the current program
to a system user (see page 72), e-mail to send a link to an external user, or Export Data, to create an
XML test file (see page 73).

Component Programs

The Actions menu functions in a similar way for component-based screens, with some additional
features. General activities include Undo, Save, Save and Create, Save as Draft (see page 74), and
Properties. Record-specific activities in the example of the Customer Create program include
Create, View, Modify, Delete, and Maintain Credit Limit.

Comments? Go to goo.gl/MfwKHm MNQAD
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Workflow

Workflow
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Workflow is available for both types of programs and is visible as an Actions menu option for non-
component based programs and as a Tools menu option for component-based programs.

Non-Component Based Programs

When you click Workflow in a non-component based program, the system creates a message for
another system user, with the current screen as an attached link. This message is then posted to the
user’s Inbox using the .NET Ul’s internal messaging system.

You can also send an e-mail link to non-system users with your PC’s default e-mail system.

Component-Based Programs

Workflow lets you forward final or draft work items to one or more individuals—identified by a
role—in the organization for completion or validation. You activate workflow using System and
User Settings.

You use the Workflow object dialog to specify the name of the workflow, the role of the recipient,
and activity they are required to perform on the link.
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Record Program Actions

Record Program Actions
Sales Order Maintenance *
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submit 3 po_vend
submit 3 _ship
submit b po_ord_date

TN i Y

The Export Data function is a test utility in the QAD .NET Ul and is available in the Actions menu
for all non-component based programs. This function lets you record your actions as you complete
an application process and save the recorded actions to an . XML or .XLS file that you store
locally. You then execute the saved .XML or .XLS file in the Execute Document Import function
to reproduce the recorded process on screen. Saved files can be exported for testing to another
QAD .NET Ul environment, or imported into the current environment.

1 Launch a program.

2 Choose Actions|Export Data. An Export Data screen is displayed (minimized) on the screen
while the system is recording your user actions. Each user action is immediately listed in the
Actions grid of this screen, and you can pause, name, and save the recording in this dialog.

3 Enter a variety of actions for the program. These actions are now recorded. The Export Data
dialog lists the actions, frames, and fields being recorded.
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Saving and Browsing Drafts

Saving and Browsing Drafts
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The Save as Draft and Browse Drafts options are available for component-based programs only
and must be enabled by an administrator in Change System Settings (36.24.5.1). When Save as
Draft is enabled, you can save selected records without completing all the validations required to
ensure that the record is complete. You can then finish adding data to the record at a later time by
using the Browse Drafts option to find the incomplete record.

Only the following subset of components provides the ability to save unfinished records as drafts
to be completed and approved later.

Banking Entry
Business Relation
Petty Cash
Customer
Customer Invoice
Finance Charge
Journal Entry
Supplier Invoice
Supplier

MQAD
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Copy
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The Copy menu is only available for non-component based programs and lets you to copy the text
of the current screen to the clipboard, or copy an image of the current screen to the clipboard.
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Print

Print
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The Print and Print Preview options are common to both types of programs. Print prints the current

screen to the default printer and Preview generates a preview of what will print for the current
screen.
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Attach

Attach

Sales Order Maintenance
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Attach lets you attach any type of document—such as a Microsoft Word file, graphics file, or
PDF—to a record within the application. This integration ensures that all required documentation
is immediately accessible when needed. You can attach and view any type of file if the
corresponding viewing software is available on the client. This is applicable to both component
and non-component based programs.

A copy of the attached document is stored in the system database, which means that the document
is always available and consistent with the application data.

Example Use the Attach option to associate a summary of a customer’s business activities with a
customer record or attach a PDF of an invoice to a supplier invoice record.

To create a new attachment, click the Attach icon in the toolbar. A standard Windows Open dialog
displays so you can select the document you want to attach. The number of attached documents
displays in the menu. To see the attachments, click the chevron in the top bar on the screen. Each
linked document displays in this view and can be removed if necessary.

Comments? Go to goo.gl/MfwKHm MNQAD


http://goo.gl/MfwKHm

78  Training Guide — QAD .NET Ul

QAD Messaging

QAD Messaging
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QAD Messaging is a messaging and internal e-mail system within QAD applications that lets you
send messages to other users of the system. When using programs, browses, inquiries, and process
maps, the QAD Messaging sidebar is permanently available on the left side of the application area
for sending and receiving messages. You can also use Messaging to process program or browse
workflow messages, which include links to programs or browses.

To send a message:

1
2

Click the New icon.

In the To field, enter the user 1Ds or names of the users to whom you want to send the
message.

In the Subject field, enter text indicating the subject of the message.
In the content area, enter or paste message content.

Click Send to send the message (or click Cancel to cancel it).

M QAD Questions? Visit community.gad.com


http://community.qad.com

Programs in the QAD .NET Ul 79

Summary

Chapter Summary

In this section you learned about

The types of programs in QAD Enterprise
Applications

The various program menu features for both
component and non-component programs

How to use QAD Messaging

Exercise and Knowledge Check

1 Sales Order Control is an example of what type of program?

2 In Sales Order Maintenance, select the Go To function. Add a link to the Sales Order Browse
program sobr009.p.

Open up a sales order and Go To the Sales Order Browse.
3 Select GL Account List, run the report, and send the output to a printer.

4 Display an existing sales order in Sales Order Maintenance by selecting it from the lookup on
the Order field. Send the sales order to your user ID by using the workflow.

a Click Actions and select Workflow.
b Enter your class login.

¢ You should see the message appear in the Messages area of the Ul. Open the message and
see what information is included.

5 Create a document in Microsoft Word. Save it to the c:\ drive and attach the document to a
purchase order.
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Chapter Objectives

Chapter Objectives
« Understand the features of browses in the
QAD .NET Ul

« Know how to customize filters, sorting, and
display options in browses

+ Know how to create operational metrics
and charts
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Chapter Benefits

Chapter Benefits
« Be familiar with the different types of
browses in the QAD .NET Ul

+ Know how to use browse features 1o find the
exact data you need

« Understand various ways of displaying
browse output

Comments? Go to goo.gl/MfwKHm MNQAD
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Training Flow

Training Flow

« Introduction

+ Navigation

+ Application Help
- Programs

- Browses

« Character Ul

- Dashboards
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Introduction to Browse Topics

Infroduction to Browse Topics

Lookup Browses
Power Browses
Browse Actions Menu, Export to Excel, Report
Browse Setup Menu
Filters and Operators
Column Options and Right-Click Column Options
Grouping and Summarizing
Component-Based Browses

Stored Search and Filter Fields
Right-Click Options and Excel Integration

Browses as Favorites
Quick Search

Using the Chart Designer
Operational Metrics

This chapter covers the following topics:
« Lookup Browses
» Power Browses
» Browse Action Menu, Export to Excel, and Report

» Browse Setup Menu
« Filters and Operators
» Column Options and Right-Click Column Options
» Grouping and Summarizing
Component-Based Browses
- Stored Search and Filter Fields
« Right-Click Options and Excel Integration

L]

Browses as Favorites
Quick Search

Using the Chart Designer
Operational Metrics

L]
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Lookup Browses

Lookup Browses
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Lookup browses return the value selected to the active field in a calling program. The lookup
browse has limited functionality. Lookup browses cannot filter, graph, or print data

In the example, when you select the Sold-To lookup in Sales Order Maintenance, you launch a
lookup browse of Customer master.

MQAD
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Power Browses
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A power browse can filter, sort, print, and graph data. Columns that cannot be sorted are generally
non-indexed fields. Sorting by them degrades system performance. Component-based and non-
component based browses share many of the same navigation features:

1 Use the navigation buttons to move through the records. The buttons from left to right move to
the first set, previous set, next set, last set.

2 Drag columns by their headings to rearrange the display or click any column heading to sort in
ascending order; click again to sort in descending order.

3 Blue text indicates a drill-down. Right-click any value to display associated links: either a
more detailed browse, a related program, or an external Web page. This slide shows the drill-
downs associated with the Order column.

Note Component browse drill-down applies to the whole record not a field.

4 Use the Records per page drop-down to determine how many records display at one time in
the browse. The default value can be set using the Rows Per Page setting in Tools|Options. (In
QAD SE, the Max Browse Records field in User Options Maintenance does not apply to
browses in the QAD .NET UI.) Some browse options are only available when displaying All.

Important Attempting to display a large number of records at once can adversely affect
performance. Instead, use search conditions to focus on specific records you want to review.

5 Click Clear All to clear browse results.
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Browse Actions Menu

Browse Actions Menu
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The Actions menu contains export and reporting options, as well as additional workflow and
e-mail options in hon-component browses.

Chart. Select Chart or Grid View to toggle between viewing a chart or the grid view of a
browse. If a chart has not been created for the browse, the Chart option is not available. Charts
are set up using the Chart Designer on the Setup menu (see page 114 for details).

Print. Select to print the current browse. The system displays the standard Windows print
dialog so that you can select a remote or local printer or print to file. When you print a browse,
all columns in the browse are printed and scaled to fit the paper size of your printer.

Export to CSV. Exports the contents of the browse to a comma-separated-value (.CSV) file,
which you can open in spreadsheet applications. The export includes only the columns that are
marked as visible, so you can exclude columns from the export by hiding them in the grid.

Export to Excel/Export to PDF. Generates an Excel worksheet or a PDF file with the browse
data.

Workflow. Sends the current browse as link to a selected user using QAD’s internal messaging
system. When the user double-clicks the link in the e-mail message, the browse is displayed.

Email. Sends this browse as a program link using the client PC’s default e-mail system.
Report. Generates a report of the current browse results.

Auto Go. Automatically refreshes the data in the browse at a user-specified rate.
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Creating Excel Output From Browses

Creating Excel Output From Browses
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Click the Actions menu and choose Export to Excel.

The export creates three worksheets in an Excel workbook, which is opened for display.
 Data. This page contains the actual data columns and headings from the printed browse.

» Search Conditions. This page displays any search conditions used to filter the printed data. The
conditions listed are field name, operator, value, and, for a range operation, the ending value.

« Info. This page lists details about the report generation including the ID of the user generating
the report, the date the report was generated, the name of the browse, and the browse program.

When you export data to Excel, any grouping is retained in the output.
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Browse Report

Browse Report
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The slide shows the output of a browse when Report is selected from the Actions menu. The data
displays in a report viewer and can be printed as needed.
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Browse Setup Menu
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The Setup menu lets you access the Chart Designer discussed later (see page 104) and two reset
options.

- Choose Reset|Sort Columns to change the direction of all column sorts back to initial settings.

= Choose Reset|Reset to Factory Settings to reset all aspects of the browse. Selecting this option
changes the search criteria, the setting for number of records to view, and all aspects of the
columns in the browse.

Note A similar Reset to Factory Setting option displays when you right-click the column
headings in a browse (see “Right-Click Column Options” on page 94). Choosing this option resets
only changes made to columns such as size, order, and sort direction.
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Filters and Operators

Filters and Operators
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“Search [sold-To ~|[smrsat [z [10c Slef-| | + % [ Search ] | Clear All ]
equals e ——
Viewing 1- 100 of B33 not equals rds per page:| 100 |
contains
Order # Sold-To & |range mber & UM Qty Ordered Gty Open Due Date | Qty Shipped | Quote & Type Purchase Order &
q 10510010 10C1000 giamsat = 0.0 100 onezn R oo 1
greater than
10510015  10c1002  |less than E4 200 200 anaezot2 1] 1
is null -
10S10015 107003 e EA 200 200 2172012 0.0 1
10510015 10c1003 3 01010 EA 200 200 Br2gr2012 00 1

1

Filtering. If you are using a component browse and stored search criteria exist, you can select
one by name from the drop-down list at the top of the search criteria. (See page 97 for an
example.) This sets up the filter criteria to produce preconfigured results. Otherwise (and
always in a non-component browse), the search fields display with a default configuration.

Note For non-component browses, you can save a browse configuration to your Favorites
and use the preconfigured criteria.

Refine the search using combinations of filters and wild cards (* and . for Financials browses).

Search Operators. The various operators include equals, not equals, contains, range, starts at,
greater then, less than, is null, and is not null. When an equal sign is displayed next to the field,
you enter an exact matching value.

Search Variable Mode. By default, you specify values for the search, such as Sold-To equals
C10553. You can also search on logical relationships such as Sold-To equals Ship-To. Click
the green toggle symbol next to the Search field to toggle between search modes.

To refine your search further, click the plus (+) icon to add another search row. You can add as
many rows as needed, each with different search values and operators. If you choose the range
search operator, the second search box is enabled for the ending value of the range. Use the x
button to remove search filters you no longer want.
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Column Options

E0-10000:0071

1 B0-10000-007

1 80-10000-001

Vi*g 197 of 17

%3 Unit DFME%SU A Uit of Measu A 7

E&

E4

Sales Order Browse X
Actions = # Setup 'i @ @ (» ® <% Addto Favorites | B =2 = | Y Create & Mo

Search (1) ) : -

| Order - | [starts at :_I [so .sQL] =] + x I Search ] [ Clear All I

\iewing 1- 828 of 828 Recordsperpage[All =]

Order A ¥ Sold-To & ¥ Satus &7 Line & 7 | hem Number & Y| UM & ¥ Qty Ordered & ¥ Qiy Open & ¥ DueDate & ¥ Qty Shipped & 7 Q
S0011301  10C1000 1 E?Pmm) | < Ea 100.0 100.0 12572013 00
50011301 10C1000 2| (Blanks) ;| EA 100.0 100.0 112512013 00
50011201 10C1000 3 g:gqg'ﬁ“ksi _o 100.0 100.0 11252013 00
50011301 10C1000 401011 100.0 100.0 1125/2013 00

»

| soot13o1 1octooo & 04007 EA 100.0 100.0 112512013 00
S0011302 10C1000 1 03021 EA 100.0 100.0 112572013 00
50011302 10C1000 2 03§ Actions 19 Frint i Addto Favorites 100.0 1125/2013 00
50011302 10C1000 3 03 Search 100.0 11252013 00

ESaIes Order ':‘i |slar|s at - : |

1 Change the column order by clicking the column header in the browse screen and dragging it
to another position in the results list. The double red arrows appear when you can drop the

heading in a new position.

2

border to the left or the right.
3

header again to sort the data in reverse order.
4

Adjust the column size by clicking on the border of the column header and dragging that
Click the column header to sort all data in the result list on any of the columns. Click the

When you are viewing all records (Records per page is All), each column header also features

a drop-down filter option. Click the icon to display the available filters. In this example, you
can filter Item Number by all (the default), blanks, non-blanks, or a specific item number. You
can also select Custom, which displays a dialog for defining a custom query.

Comments? Go to goo.gl/MfwKHm
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Right-Click Column Options

Sales Order Browse X
Actions = # Setup ~| (@) &) & & ¢ Add to Favorites | E 2] &

Search (1)

Order |[satsat  ~|[s0 Pla)- | | + x Search || Clea
Viewing 1-828 of 828 Records per page: Al -
Order &V SoldTo ¢ ¥ Status &7 Line & ¥ ltemfumb « ¥ UM &% QivOrdered &5 QtyOpen$ ¥ DueDate & 7
SO011304  10C100T 1 0j04{¥] | Autosize Columns 40 1252012
SO011307  10C1003 1 010H Card View ] 40 112502013
SO011310  11C1000 1 0101 Seonp By Mem Nitmber 20 112512013
50011310 11C1000 5 0101 Show Group By: Box 20 112512013
SO011313 121000 1 0101 R s 20 112512013
SO011313  12C1000 5 0101 Expand All Geotips ] 20 112512013
SO011317 2001002 1 0101 Collapse All Groups 10 112512013
SOD11317  20C1002 3 0101 Summary » 20 142512013
SO081204  30CT007 1 0101 Clear All Filters 20 812512012
SO081207 10C1003 1 0101 i 20 8/2512012
Hide Column

SO0E1210  31C1000 1 0101 10 BI2512012
Reset to Factory Settings

SO081210  31C1000 5 0101 10 B/25/2012
Columns

SO081213  22C1001 1 0101 . 10 BI2512012
Properties

50081213 22C1001 5 0101 10 8/2512012

SO081217  21C1001 1 01010 EA 20 20 B/25/2012

Right-click a column heading to display a list of options.

Use Autosize Columns to resize browse columns based on the size of the displayed data. By
default, the browse displays with columns already autosized. If you turn this option off and
manually adjust column sizes, your settings for each browse are retained between sessions. If a
cell’s data exceeds the column width, three dots (...) are displayed on the right.

Use the Group By functions to create and manage custom views of the browse data. Group By
functions are available only when all records are being viewed.

Use Summary to get a summary of the data in the browse column.
Use Hide Column to remove a column from display.

Use Reset to Factory Settings to return to the default column display settings. The search
conditions, autosizing, page sizing, and chart definition are all reset.

Note This Reset is a subset of the reset on the browse Setup menu, which resets all aspects of
the browse.

Use Columns to display a list of all columns defined for the browse and toggle the show/hide
settings. You can use this to restore a column that was previously hidden. This option displays
the Column Maintenance screen, in which you select the columns to be displayed and the
position in which they appear on the screen.

Use Properties to display technical information about the data in the column. This includes the
name of the current program and the database table and field where the data for the column is
stored.
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J Sales Order Browse X |

Grouping Browse Resulis

Viewing 1-826 of 826 Records per page,-i‘».ll

Actions = # Setup -~ @ Cancel | (@ &) & & ¢ Add to Favorites
Search
|Order - | |starts at - | (QE] -

v

Order A ¥ Sold- - sber &7 UM 27
Autosize Columns
TRANS2 20C1Q i
Card View Sales Order Browse %
TRANST 30C1Q
SOEAMT00  10C1d Group By Sold-To robe Actions ~ i Setup | @ @ & & ¢ Add to Favorites
SOEAMI00 1ocig  ShowGroup By Box ousing | Search
SObws10  30C10 ECnor Sieping |Order v |starsat v S -[
Expand All Groups = -
SObws10  30C1(Q :
s e Viewing 1- 839 of 839 Records per page:| Al -
SObwsi0  30C1Q ollapse All Liroups
Cimenar 3 + Sold-Tor10C1000 (108 items)
EbSUR e + Sold-Te:10C1001 (44 items)
S0bws10  30CTQ : + Sold To:10C1002 (54 items)
SObws10  30C1Q thide Golumn + Sold-To:10c1003 (16 items)
SObws10 a0Cc1d Reset to Factory Settings + Spld-To:10C1004 (36 items)
SObwsi a0cio o - Sold-Te:10C1005 (3 items)
Order £V Status £ 7 Line & 7 ltem Number £ W UM £ ¥ Qty Ordered & 7
SObws10  30C1Q Properties e L ne &7 ltem Humber & ¢ by Ordered &
R e S0100001 1 01040-001 EA 10
W3
50100001 2 01040-002 EA 10
S0100001 339 00

+ Sold-To:11C1000 (48 items)
+ Sold-To:11C1001 (36 items)

This slide shows the result of grouping sales orders by Sold-To Each group can be expanded using
the plus sign next to it. You can also add other columns to the grid to create a group hierarchy.

Group options are saved automatically in your last used settings, and can be reused when you open

this browse again. You can also save

these options as a stored search.

Add other columns to the grid to create a group hierarchy. Group options are saved automatically

in your last used settings, and can be

reused when you open this browse again. For component-

based browse, you can also save these options as a stored search.

Comments? Go to goo.gl/MfwKHm
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Summarizing Browse Results

Sales Order Browse X |
Actions v ¢ Setup v| @) W () & ¢ Add to Favorites B 3 :: | Create ## Med
Search |
Order o | P e E - + X Clear All
Viewing 1- 839 of 839 Records per page: All -

Order 4V Saus £ 7 Line £V ltemNumber £ % UM £ W Qty Ordered ¢ ¥ Qty Open £ ¥ Due Date & ¥ Qty Shipped & 7 Quot
50700001 1 01040-001 EA 10 10 82472012 0.0
50100001 2 01040-002 EA 1.0 1.0 872472012 0.0
50100001 999 0.0 0.0 215201 0.0

Summaries

Count=3
| Sum =20
] Average = 06666666667
: Minimum = 0.0

Maximum = 1.0

The Summary right-click option lets you display summary information, depending on the column
header you clicked. The option is context sensitive and displays choices based on the data you are
viewing. For some columns, you can only summarize by count. But the Quantity Ordered column
can be summarized by the total sum of ordered amounts, count, average, and the minimum and
maximum amounts.

Count. Displays the number of records

Sum. Displays a total sum of the open quantity
Average. Displays the average of open quantity
Minimum. Displays the lowest open quantity
Maximum. Displays the maximum open quantity

You must be viewing all the records on the screen to use the Summary option. If there are more
records than can be displayed, set Records per Page to All.

Note You only see meaningful results if the operator you choose applies to the data type. For
example, applying the average operator to a date column does not produce a meaningful result.

Minimum and maximum are useful with dates, and summary and average with numeric fields.
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Component-Based Browses
JSuppIier Invoice Browse for Mo.. X |
Actions = # Setup ~| (@) (4) () () 5 Add to Favorites a Stored Searches '.'% B =0 : | Create # Modify $§ Delete
Search (B) | Factory Default {a_
SUP‘P“.H Code v | |equals -] /‘-) E Manage Filter Fields ... X Clear All
Business Relation ~ | |equals - ,»JE Save x
Reference ~ | \equals - E SaveAs... x
Year | equals - [1 Seicte x
Daybook Code = |equals - Ol=)- | + x
Viewing 1- 100 of 661 Records per page: | 100 -
Supplier % BusinessRel ¢  InvDate £ Reference & TCBalance & Cur ¢ DueDate & Description &
[ 105C1005  10-C1005 10/9/2010 OIS HO2 491.50 USD 11/22011 OI S HO2 10SC1005
1051001 10-51001 5/5/2010 PO051001 0.00 USD 6/472010 POOD51001 1051001
1051002 10-51002 5/5/2010 PO051002 0.00 USD B/472010 POOS1002 1051002
1051003 10-51003 5/5/2010 PO051003 0.00 USD 71472010 PDOS1003 1051003
1051004 10-51004 552010 PO051004 0.00 USD 7472010 PO051004 1051004
1051005 10-51005 5152010 PO051005 0.00 USD 51572010 POD51005 1051005
1051006 10-51006 5/7/2010 PO051006 0,00 USD 6/6/2010 PO051006 1051006
1151000 11-CS1001 5(7/2010 PO051007 0.00 CAD 83172010 POD51007 1151000
1151001 11-51001 /772010 POO51008 0.00 CAD /772010 POO51008 1151001

Component-based browses are launched when you view, modify, or delete a record created with a
component-based activity. For example, Supplier Invoice View (28.1.1.3), Supplier Invoice
Modify (28.1.1.2), and Supplier Invoice Delete (28.1.1.9) all launch browses, in which you select
the record on which you want to perform the activity.

Component-based browses support some unique features.

» The way links work is different in these browses. Right-clicking a record lists programs that
can be used to modify or display information about the record. This linking is maintained
automatically by the system; you do not need to set up drill-down links in the way they are
defined for non-component browses.

« Another special feature is stored searches. The Stored Search menu is shown in this slide.
Using this menu, you can save a set of search criteria under a name. The stored search is then
listed for selection when you launch this browse and can be reused. The settings you save
apply to this browse only and are not listed in browses for other types of records.

Note With non-component browses you can save a configured browse to your Favorites,
which saves all your settings, but you cannot save the search criteria and load it directly into
the browse.

- Additional options are available when you right-click a browse row. Some component browses
support an advanced Excel integration.

Comments? Go to goo.gl/MfwKHm MNQAD
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Supplier Invoice Browse for Vi.. 3{|

Managing Filter Fields

Actions ~ # Setup v| ® @ (® () i AddtoFavorites

& Stored Searches ~

| [) Create # Modity 3¢ Delete

|8 2 i

i .Searc.l.'l l2D) Factory Default @
|5UPP|IEF Code - iequals id | | Pi o Manage Filter Fields ... | x
|Businas Relation = : |equals - | | ,O[ o Save b 4
|Referenoe - | !equals - | | [ deni = B
g ; & Supplier Invoice Browse for View - Manage Filter Fields EI_Ig
| Year - | equals ~ ||
|Daybonk Code & I :equals = | | Label 4 Misible 4 Operator 4 First Initial Value ¢ Second Initial Value!i'
: ] M equals H
|\‘"mhh°|d‘”9 Tax = !ﬁquals = | | Business Relation [l equals i
| . 1T 1T Reference [l equals
Viewing 1- 100 of 661 Records per pag Year vl equals
[ I
Supplier L Business Rel & Inv Date & Reference Dayhook Cade bl equals
= \Withholding Tax e |
| J 105C1005 10-C1005 10/9/2010 Ol SHO2 SC\WHT Base Am = els |
1051001 10-51001 552010 PO051001 BCWHT BaseAm  [ul  equals
1051002 10-51002 B/B/2010 POOS1002 TC \WHT Base Am Il equals
1051003 10-51003 562010 POO051003 SCWHT Base Am vl equals
1051004 10-51004 5/52010 PO051004 BCWHT BaseAm [ equals
1051005 10-51005 51512010 POOS1005 A Eeee e
SC WHT Total Am vl equals
10S100E 1051008 sgooin pogstone fil |00 S LL DT M
g BCWHT Total Am [f  equals |
o — A
| il |
I oK |[ cose |

Manage Filter Fields displays all the search fields possible for this type of record. You can use the

options to:

Specify whether a filter field should appear on the Selection Criteria tab (Visible column).
Specify in which order the filter fields should appear.

Specify what operator to use when finding data to view.

Define a persistent initial value or range of values for the filter field. The values for search

criteria entered in the actual Search Panel are not saved with the stored search. However, the
initial values entered in Manage Filter Fields are saved.

within a number range of 1000 to 5000.

MQAD

You can refine the default search for GL accounts to retrieve only accounts with codes that are
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Right-Click Component Browse Options

Supplier Browse for Modify * }

Actions * ## Setup ~| (@ (1) (® (= ¢ Add to Favorites & Stored Searches ~ B = :: | Create o Modify
Search ) Modify [?
T &9 Create
i - - = < Search Clear All
Supplier Code _Bqua!s © View | + | ear ear
Viewing 1-59 of 59 Records & Delete
&) Excel Integration
Supplier % W Business Relation Code & W Bu g ) Activity Dashboard %+ W ZipCode & W City % ¥ County & 7 State 3
10-300 10-USA-CO Pvenue 07350 East Hanover NJ

M
&¥ Supplier Invoices

10L1000 10-L1000 L ) Supplier Invoice Payments Flace 07302 Jersey City NJ
10L1001 10-L1001 Uty Supplier Balance Street 90501 Torrance CA
10PLATSP 99P5-10 Plz%® Withholding Tax 55466 Louisville KY
1051001 10-51001 Tallg) Supplier Account Activity jue 4220 Palmetto FL
1051002 10-51002 Bril&) Supplier Report jad 43127 Stevensville M
1051003 10-51003 He{ . Stipplier Oper ltem Report e 11432 Queens NY
1051004 10-51004 Sul ¥ Dump XML eet S0021 Los Angeles  Los Angeles CA
9 1051005 10-51005 T8 (L) Force Publish Drive 07039 Livingston NJ
1051006 10-51006 Hampton Electronics 17031 Commercial B. 33421 Boca Raton kL

Component-based browses support additional drill-down and configuration options for individual
records through the right-click menu. For example, when you right-click a grid line in the Supplier
View browse, the options shown in this slide display. Most of the options let you navigate from a
specific record to a related program. You can select a supplier and then see open items for the
supplier, the supplier’s balance, the supplier’s invoices, and so forth. The exact options vary
depending on what kind of record you are viewing.

Additional component-based options that are not related to specific records are:
Excel Integration. This option lets you export data into Excel spreadsheets, create new data
within Excel, and import it to the system database, where it is validated before being saved.
Note This advanced bi-directional Excel integration is supported in only a subset of
components.

Dump XML. Select to export selected lines to an XML file for analysis. You are prompted to
specify a name for the output file and a format. This option is described in more detail in User
Guide: QAD System Administration.

Force Publish. This option is used with event publishing that lets changes to master data be
published and synchronized with other external systems and is described in more detail in
User Guide: QAD System Administration.

Comments? Go to goo.gl/MfwKHm MNQAD
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Excel Integration

Excel Integration

Right-clickthe browse  em i
and choose Excel s B
Integration e

) Inthe empty grid, right- |
click and choose Load i
Suppliers @ m

3. Right-click and choose
Export to Excel for e e e R
Maintenance R - R
Save the Excel file, open : e v
it, and modify it o EL:ZZZ,:.T'.. |
Right-click in the grid R
and choose Impott from S el |
Excel P o] |

Using Excel Integration has multiple steps. This example uses supplier records.

1
2

Right click in a Supplier browse and choose Excel Integration. An empty grid displays.

Right-click in the empty grid and choose Load Suppliers. The Load option lets you retrieve all
database records for a supported business component.

When the load completes, right-click in the grid and select Export to Excel for Maintenance.

Save the Excel file in a folder that can be accessed so that the Excel sheet can be modified.
Make the required changes to the Excel file and save it.

Return to the supplier browse, right-click grid and select Import from Excel. Click Save to
create or update the data in the system database.

The changes you made should now be reflected in the database records.

Note With Excel Integration, you can also import from Excel to create new records without
exporting first.
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Browses as Favorites

Sales Order Browse *
| Actions ~ ¢ Setup ~| @ @ () &[4 Add toFavorites |8 2 & | [ Create
e | | |
ol | - |+ =
[ship-To ~|[stetsat  ~][cutso Pl=2] - | | + =
Viewing 1- 100 of 839 Records per page:[ 100 |
Order # Sold-To & Ststus Line ltem Number & UM Gty Ordered Gty Open Due Date  Qty Shipped Quote & Type Purchase Order £
¥ 10510010 1ocio00 1 60007 EA 100 100 10142011 00

10510015 101003 1 01010 EA 200 200 2132012 00

10510015 101003 2 n1oto EA 200 200 82112012 00

10510015 10c1003 3 n1o10 EA 200 200 2282012 00

AUTO1  12C1001 1 02200 EA 00 00 812412012 00

AUTO2  22C1000 1 02200 EA 00 00 00

Non-component browses do not support the Saved Search feature, but you can save both types of
browses to your favorites:

1 Click the Add to Favorites button.

2 The browse is saved to your Favorites area and named based on the name of the browse.

If it is the first instance you have saved, the browse name in the Favorites area is the name of
the browse. If you save the same browse again, a (2) is appended to the name in the Favorites
area.

3 Once you have saved the browse to the Favorites pane, you can rename the browse and
organize it in the same way as other items saved in the Favorites pane.

Comments? Go to goo.gl/MfwKHm MNQAD
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Renaming Browse Favorites

@ Applications

#HT Customer Management
BT Supply Chain

Eu’j Manufacturing

E‘hj Financials

#HT) Master Data

FHE) System Administration

9.7 Favaorites

#H[E| Set Up General Ledger
" Sales Order Browse
E/Z;alm Order Browse (2)

[

Renaming Browse Favorites

P Acll'ons'f Setup'| .'_;_\J @ @ 9

3‘ Sales Order Browse %

¥ Favorites
|| Set Up General Ledger
-[# Sales Order Browse

m

ﬁ“- Sales Order Browse (2}

/

[2 Rename
E Changelcon
@ Remove
Auto Start
Collapse Menus
Open
Design

Properties

{:D:} Applications

'E‘ =3 Customer Ma

&3 {51 Supply Chain

[+ Manufacturing

= Financials

'E‘@ Master Data

&3 {5 System Administration

7F Favorites
#H{[E] Set Up General Ledger
: ' Sales Order Browse

R L1500 Brovse

To rename a browse:

1 Right-click the browse.

2 Click on Rename.

3 Enter a new name for the browse.

MQAD
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Quick Search

Sales Order Browse X
Actions ~ ¢ Setup ~| (@ (&) (® &) 1 Addto Favorites [ Quick Search
Search 1) [Startswith  v[c B
| Search For [%E [Stariswith = | [c =] - B
Expires T = . -[5F End User Browse
Villiem Number Tii Recoeds pacpaie | 100 hdl . [& CallCollection
Line i
COrder —(Status &7 Line & ¥ ltem Number & ¥ UM & 7 = ¢ Customer Data
’F’urchase Order 1 01010 * B Customer Collection
Qty Open
Qty Ordered 1 04001 EA
Qty Shipped A
Quote 3 1 02301 EA
Ship-To 3 1 02302 EA
Site
Sold-To 1 02303 EA
Sty 1 03021 EA
Type
1 |UM | 2 03022 EA
e 3 03023 EA
50011322 30C1000 4 03033 EA

The Quick Search filter (*Search For) is available in all power browses and lets you search for a
value across all of the fields in the browse. Quick Search looks for integers and text strings only
and does not retrieve dates.

Use the *Search For option from the Search pull-down list in a browse to retrieve all the results
that contain the search value in any of the columns. Choose the Contains, Starts With, or Equals
operator for the system to use when searching across columns in the browse data.

You can also create groups of browses for quick search purposes by adding them to the Quick
Search panel. By default, the browse groups area of the panel is empty. Create a new browse group
by right-clicking on the panel and selecting New to create a new browse folder. Add individual
browses or browse collections by selecting the folder and dragging and dropping browses from the
Applications panel.

After you have created the browse groups, select one and enter a search term in the Quick Search
field. Press Enter to search the browses contained in the folder for the term. The results display in
browse format in the workspace.

Comments? Go to goo.gl/MfwKHm MNQAD
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Using the Chart Designer

Y Browse Chart Designer — . u|
Browse Chart Designer
X-Axis Label: Product Line Chart Title:
X-Variable: |Prod Line - Itemn Browse
1

Y¥-Axis Label:  Item Mumber Item Browse

Group By X Values: |.1D a2 30 Wothers

Y-Variables:

|Hem Number X | |Cuunt

| '| | +4.00%

- 18.00%

48.00% v,

' | =] |

Item Number

30.00%

Product Line

With the Browse Chart Designer, you can:
» Quickly generate graphical representations of browse data.
= Toggle between the standard browse display (called the grid view) and the chart view.

« Use the chart view editor to select data in a browse and display the data in graphical format,

such as a pie chart or bar graph.

MQAD

Questions? Visit community.gad.com


http://community.qad.com

Browses in the QAD .NET Ul 105

Creating Charts from Browses

Creating Charts from Browses

From a browse, choose Chart Designer
from the Actions menu

Design a chart using the Browse Chart
Designer
Set X- and Y-Axis labels

Set X and Y variables e .
Group By X Values oot — S—

Chart Title m—
Chart Type e e !}
Preview : :

The Browse Chart Designer lets you choose settings that define a chart:
X-Axis and Y-Axis Label. Enter the label for the chart’s x and y axis data.

X-Variable. Select the variable for the x-axis data from a pull-down menu listing the available
columns in the browse.

Y-Variables. Select up to five variables for the y-axis data from a pull-down menu listing the
available columns in the browse.

Group By X Values. Select Yes if you want to display all the common x-axis data together in
groups. Select No if you want to display the x-axis data individually.

Chart Title. Enter a title for the chart.
Chart Type. Select from among the available chart types.
Preview. Click the Preview Chart button to view the chart before you save it.

You can toggle between the chart view and the grid view of the browse by selecting Chart or Grid
View on the Actions menu. If you are in chart view, Grid View is displayed on the menu, and if
you are in grid view, Chart is displayed.

Comments? Go to goo.gl/MfwKHm MNQAD
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Chart Options
Rotate and Zoom 3D Charts

Search Charts P
Hide Titles T e
Hide Legend v —_—
Launch in New e S e r D g
Window
Copy to Clipboard :
Edit Chart Design
Interactive Charting m”:‘“

Sales Orders

While in chart view, you can do the following:

Rotate and Zoom 3D Charts. You can rotate 3D charts by pressing the Alt key and moving the
mouse. Similarly, you can zoom 3D charts by pressing the Alt key and moving the mouse’s
scroll wheel.

Search Charts. The QAD .NET Ul’s browse search capabilities apply to the chart view as well
as the grid view. By using the search capabilities you can interactively change the chart view
of the browse.

Hide Titles and Legend. Chart titles and legend are shown by default. You can hide (or show)
titles by right-clicking and selecting Hide Titles (or Show Titles). Similarly, you can hide (or
show) the legend by right-clicking and selecting Hide Legend (or Show Legend).

Launch in New Window. To launch a chart in a new window, right-click the chart and select
Launch in New Window.

Copy to Clipboard. You can copy the chart to the clipboard so you can paste it in other
applications. To copy the chart to the clipboard, right-click in the chart area and select Copy to
Clipboard.

Edit Chart Design. To return to the chart editor, select Chart Designer from the Setup menu.

M QAD Questions? Visit community.gad.com



http://community.qad.com

Browses in the QAD .NET Ul 107

Interactive Charting

Interactive Charling

For any item that has a drill-down, display @
split-screen view of both the chart and the
drillF-down browse, which can also be
displayed as a chart

- Click anitem in the first chart fo automatically
change the view to reflect the changed data for
the drill-down

- Click anitem in the chart to select the
associated row in the browse

- Conversely, click arow in a browse to select the
associated item in the chart

For any item in the chart that has a drill-down, you can have a split-screen view of both the chart
and the drill-down browse, which can also be displayed as a chart.

= When you click on an item in the first chart, the drill-down chart will automatically change to
reflect the changed data for the drill-down.

« Clicking on an item in the chart also selects the associated row in the browse.
» Conversely, clicking on a row in a browse also selects the associated item in the chart.
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Operational Metrics

Operational Metrics

File Edit Tools Workspace Window Help

@ Applications — || AR Operations *
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F] Banking/GL Name Result Total
(@ CSR Metrics - Order Lin
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L tem ABC Code Metrics
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[} (3

Eis

¥ Favorites : y

LRI Set Up General Ledger | Total {Customer Invoice Analysis (Current Quarter)) s
# &) Containerize Sales Order Ship

o |

CalasClad

The Operational Metrics option lets you create a graphical metric from browse data. Operational
metrics provide a live snapshot of production data, which lets you monitor in real time how the
system is being used. You can use operational metrics to visually track any type of browse data,
including data from customized browses created in Browse Maintenance.

A number of predefined metrics are supplied with the system in the Metrics folder. In this slide, the
Accounts Receivable metric displays different customer metric results.

Metrics are created and managed by administrators using the Create Metric Collections function
on the Administration menu.
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Creating Metric Collections

Creating Metric Collections

[Unwed x
e Refresh &) Stop (=0 Print » Print Preview | | | New ¢ Edit | ' AddtoFavorites | [ Save 3£ Delete
Untitled

Total (Untitled) |

Title | S Customers By Site
Untitled

1 Select Create Metric Collection from the Administration menu to create the initial metric
collection. The system prompts you to name the collection.
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Creating Metric Groups

Creating Metric Groups

-
Y Create Metric Group - Hﬂg
Actions - | @ @ @ :«)
Search @
e — T PR [ |+ x
Viewing 1- 100 of 1484 Records per page: | 100 -
Name » Description View % Power Lockup SortColumns DragBack UserID Mod Date  Term |j
ab001 Customer Order Processing __wvwab001 Yes Ho 0 emb 10/2008 CUSTDMi E|
| 3 ad001 Customers cmmstr(1 Yes No 2 jpm 12722008 CUSTOME
ad002 Customer Controls Browse rcc_msir Yes No 0 mfg 726/2011 CUSTOM
2d005 Dock Addresses admstr| L e — (5|
=d006 y
Employees ety Tide | EHNTRIRINST] Beowme Program  adbel0lp
ad007 End User Addresses eumsir Unitied
ad008 Lddress List Types Ismstri |
[Search [7)
l 2d010  Salespersons Spmstrl (| (e v latas - A=) - + x [Csoen ][ cean |
M| adD14  Suppliers vdmstr]
: 5015  Country Codes ctry_m
ad016 Rounding Methods md_m|
ad022  Camiers admstr]
ad023 Customers and Ship-Tos Ismstri]
ad027 Ship Vias code _r|
(IR
L
o Carel

2 Right-click the collection title, or select Edit|Create Metric Group to create a metric group for

the collection.

3 Alist of browses in the system displays so you can select the parent browse for the group.
Double-click the name of the browse to select it.

4 You are prompted to name the Metric Group. Enter a name for the metric group (for example,
Customers by Site) and click OK. The system then prompts you to create the first metric.

MQAD
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Creating Operational Metrics

PN Create Metric el Eh

Title | Customers for Ste 10-100

Unfitied ‘i 1
Type | Count - ~ | |Percent - 1 - m
i ]
Search (1) @)
Site | [oquats < |[10-100 Pl3) - + x Clear Al !

oK Cancel |

Title. Enter a title for the metric (for example, Customers at site 10-100).

Type. The default type is Count. When you select the Count type, the browse filter drop-down

is unavailable. Type options depend on the type of browse. For browses that produce

numerical values as results, you can also choose Sum, Average, Maximum, or Minimum as the
Type option. When you select a type other than Count, you can then select the value to which

you apply the type.

Percent/Range. Select Percent to display the metric as a percentage of the browse total.Select
Range to display the metric as a range of figures. This option lets you increase the granularity

of the results.

Search. Select the browse filter, operator, and value to define the metric. For example, this
metric is based on the number of customers in Customer browse whose site code equals

10000. You therefore select the site code filter to equal 10000. You can set multiple filters for
the metric, as you do on a normal browse. Click Search to find out how many sites meet the
criteria (in this case, the number is 33). This information is displayed as a percentage of the

total (when you have selected the Percent display option). Use the slider controls on the
percentage bar to set the color code for thresholds.
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Editing Operational Metrics

Editing Operational Metrics
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Custorrers at sike ZM1I00 u Al BUoosu U i
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You can edit metric details by right-clicking the metric name on the main screen and selecting
Edit. Click on the Save button to save the operational metric to the Metrics folder, New to save the
metric for the first time, and Replace to replace an existing metric.

The metric is now available in the Metrics folder. You can add operational metrics to Favorites. To
refresh the metric information, rerun the individual browses from within their metrics.
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Summary

Summary

Browses let you to display selected data in
different formats

« You can use advanced filtering, sorting, and
column options to adjust the data you see
to your needs

+ You can display browse data as charts or as
operational metrics

- Operational metrics can be used to display
operational deficiencies in real time
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Exercise and Knowledge Check

1 Open up the Sales Order Browse. Highlight any Sales Order and drill down by double-clicking
a Sales Order number. In the Sales Order Maintenance screen that appears, click the Sold-To
lookup.

2 Go to Supplier Invoice View and display a component-based browse.

3 Use Sales Order Browse and limit the output of the Sales Order Browse to orders for one
specific customer.

What filter did you use? What operator did you use? Send the output to an Excel sheet.
4 From the Metrics folder, display the Accounts Receivable metric.
5 Run Excel Integration for Country Browse. Delete a country and re-import the Excel sheet.
6 Run Sales Order Browse and rearrange the columns. Group the results by Sold-To.

7 Use Chart Designer to create a chart for Item Master Browse.
Label the x axis Product Line and select the variable prod line.
Label the y axis label Part Number and select the variable item number and group by count.
Select a 3D pie chart and run the chart.
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Chapter 6

Using the Character Ul
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Chapter Objectives

Chapter Objectives

« To infroduce the functionality of Character
User Interface (Character Ul or CHUI)
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Chapter Benefits

Chapter Benefits

« You willbe able to use and navigate the
Character Ul of QAD Enterprise Applications
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Training Flow

Training Flow

« Introduction

+ Navigation

+ Application Help
- Programs

- Browses

- Character Ul

- Dashboards
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Introduction to Character Ul

Infroduction to Character Ul

« Character Ul depends on input from the
keyboard

- A command-prompt interface to execute
programs

- Combinations of keystrokes to issue commands
withinprograms

- Navigationwithout use of a mouse through the
UNIX characterinterface
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Character Ul Login Screen

Character Ul Login Screen

P 172.16.28.81 - PuTTY

W R M S

QAD
100 Innovation Place
Santa Barbara, CAL 93108

{805) 684-6614
{805) 565-4202 FAX

User ID: .

Password:
Domain:

QAD Enterprise Applications 2010 - Enterprise Edition as of Feb 24 2010

Copyright 1986-2009 QAD Inc:.  All rights reserwved.
This product mway not be reproduced or distributed
Aetive Users: Defined Users:

[ji=1%

Enter data or press F4 to end.

To start a character session, follow the procedures provided by your system administrator. The first
screen you see after launching the system lets you log in to the system. Enter the login ID assigned

by your system administrator and your password. If you have

been given access to more than one

domain in the system, enter its name in the Domain field. If you have access to only one domain,

this domain displays in read-only mode. You must be a valid
blank only if the password in your user record is blank.

MQAD

user to log in. Your password can be
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Main Menu
#P172.16.28.81 - PuTTY =Jojed
QME US : gaddb -~
‘mfmenu Main Menu 05/26/10
1. Items/Sites 13. Product Structures Z5. General Ledger
2. Addresses 14. Routings/Work Center 26. Multiple Currency
3. Inventory Control 15, Formula/Process 27. Accounts Receivable
4. Warehousing 16. Work Orders 28. Aoccounts Payable
5. Purchasing 17. Lean Manufacturing 9. Tax Management
B 18. Repetitive 30. Cost Management
7. Sales Orders/Invoice 19. Quality Management 31. Banking/Cash Mgmt
8. Configured Products  20. Product Line Plan 32. Fixed hssets
9. 21. Resource Plan 33. Enterprise Ops Flan
10. 22. Forecast/Master Plan 34.
11. Service/Support 23. Materials Rgmts Plan 35. EDI eCommerce
12. Distribution Plan 24. Capacity Romts Plan  36. System Admin
Please select a function. F4 or blank to EXIT [
Press Fz for Help [ne]

QAD Enterprise Applications has locations for 36 modules on the character-based main menu. In
turn, each module has one or more menus attached to it. Menus are lists of programs you use to
look up or input data.

The menus that you see depend on the security access that has been granted to your role. Only
menus with programs that you have access to display. When you enter a menu number on the
command line, the system either executes a program or displays a lower-level menu. You can keep
drilling down through the menus until you reach the appropriate level. Alternatively, you can
access a program directly by entering its Progress name—such as ppptmt. p for Item Master
Maintenance—or number at the command prompt.

If the current menu displayed is System Admin (36), you can enter 2.13 to access Generalized
Codes Maintenance. However, you must enter .1.4.1 to run Item Master Maintenance (1.4.1)
because it is on a different submenu.

You can also use the arrow keys to move around the menu, then press Enter to execute the
highlighted selection.
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Menu Substitution

Menu Substitution

36.4.4.7 Menu Substitutio aintenanc 05/Z6/10
Execucion File: Embrooi.p ‘

HNew Execution File: frmmaig.p
Jelection Label Term: FORMULA CODE_INQUIRY
Formula Code Inguircy

Fl=Go 2=Hlp 3=Ins 4=End 6=Mnu 7=Rcl S=Clr 9=Prev 10=Next 11=FBuf |$

Menu substitution lets you toggle between displaying browses and inquiries on the menu. You can
also use it to switch between customized and non-customized versions of a program. The system
administrator can use Menu Substitution Maintenance (36.4.4.7 in EE, 36.20.6 in SE) to specify
which programs are substituted for others when you select this option. By default menu
substitution is disabled. It can be enabled for individual users in User Maintenance (36.3.1).
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Program Screen Elements

Program Screen Elements

P 172.16.28.81 - PuTTY

Tifle bar ElE] : Order Maintenance
i Purchase Order: !OSl Supplier: 505800 Ship-To: US-W-S ‘
——————————— Supplier Ship To
Sandwich Factory us-w-3
PngrOm = Storey Street 530 1 California Boulevard
Window
Vickery COH OH43454 San Diego Ch 92104
UNITED STATES UMITED STATES
Order Date: 07/08/07 Price Thl: Confirming: Yes Imp/Exp: No
Due Date: 07/08/07 Disc Thl: Currency: USD Language: us
Do Buyer: Ln Disc: 0.00 Taxable: No H
o e Bill Ta: US-W-5 Site: US-W-S  Fixed Price: Yes Consign: No
Frarme Sales/Job: Daybook Set: Def AP  Credit Terms: 2N 0.00
Contract: Project: Entered By: lvh
Contact: Requested By:
Remarks: Comments: No
Progress
Stortus Bar F1=Go 2=Hlp 3=Ins 4=End 6=Mnu 7=Fel §=Clr 9=Prev 10=Next 11=Buf

The title bar identifies the program currently running. What displays in the title bar depends on the
Header Display Mode setting in Security Control (36.3.24). Based on that setting, you may see any
of the following elements:

 The title bar includes—from left to right—the program name, the version of the program, the
menu number and title, and the current date.

 The title bar is the same as previous except that the login ID of the current user replaces the
current date.

« The title bar includes—from left to right—the short name and currency of the current working
domain, the menu number and title, and the current date.

 The title bar is the same as previous except that the login ID of the current user replaces the
current date.

Program Window

 The program window displays the frames and fields of the current program.
Progress Status Bar

 The status bar shows the basic commands needed to navigate through the specific program
currently displayed in the program window.
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Character Ul Browse

‘ﬁ- 16.28.150 - PuTTY

Character Ul Browse

User Menu Edit Options Help Type m‘\— [l
o05/z6/10
Type Description fze/
Trans Type:|| >Fi Fixed ALssets
Trans Type Doc Type From Ic Inventory Control e
le] Fales Qrders
> o Work Orders SDB
1 FLE
Ic CET-ADJ e
Ic ISS-PRV TRV
IC I185-80 E0
Ic I35-UNP THE
1c I1ss-wo WOISS
i< MATL-VAR WOMVAR
1< RCT-FQ RCT-FQ
Ic RCT-50R RCT-30F
Filter = Off

Fl=Go 2=Help 3=Ins 4=End 6=Menu 7=Rcl B8=Clr ll=Paste

Browses display selected data in the form of a table. Browses in the character Ul are similar to
those in the .NET Ul, but have a simpler set of features. Two types of browses are available:

« Lookup browses return the value you select to the active field in the calling program.

- Drill-down browses display, filter, or print data.

MQAD
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Browse Menu Bar

Browse Menu Bar

22 172.16.28.150 - PuTTY QE

UESSRENE Edit Options Help 14
Definedin
User Funciion Default Daybook Browse DS:’ZSIlD‘
rnaintenance Print  CTRL-P
Run Frogram... CTRL-R Entity To Entity Daybook
[a]n]e{s]y =
Menu Exit ESC-X
= |
; USSYIDE
Maintenance s ICDEFDS
Ic C3T-ADJ std cost
Ic IS3-FEV He 1|
Ic I35-50
Ic I35-TNFP [Fontents
Iic IS5-wo /| Interface Help
Ic HMATL-WVAE
Ic RCT-FO Field Help
Ic RCT-50OR Procedure Help SHIFT-F1
‘| Drill-Down ESC-TLE
Filter = Off Look-up Browse FZ
Aoouc. .. CTRL-F1 :5_
i

To scroll through the records, use the Up and Down arrows.

The User Menu in the browse menu bar differs from the User Menu accessed by pressing F6. The
User Menu in the browse menu bar provides access to:

« Print Options
* Run Program
» Exit

Edit

Cutting text deletes it from its current location and copies it to the clipboard. Copying is similar,
but it leaves the original text in place. In both cases, you can paste the text to another location, such
as a field.

1 Choose the text to cut or copy.

2 Display the Edit Menu. This menu choice is available only when text is selected.
3 Choose Cut or Copy.

4 Position the cursor in the new location.

5 Choose paste.
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Options

- Browse Options. Use this option to set up filter criteria for browses. The filter criteria limit the
viewable records according to your specifications. For example, you can filter out product
numbers or statuses that you do not want to view.

« Toggle Filter: Use the toggle filter setting to turn on and off the filter criteria set up in the
browse filter options.

Help

Use this menu to access help on fields, as well as display drill downs and lookup browses on
selected fields. The fastest way to get help for the current field is by pressing F2 twice: press F2
once and, if available, a lookup browse displays) but you can also bring it up with the Help menu.
With the cursor in the field, drop down the Help menu and choose Field Help and procedure help.

Output Devices

You can send the output from reports, inquiries, and browses to a number of devices, including the
following:

« Your terminal
« A server printer
« An e-mail message

However, the character user interface does not offer as many options as the QAD .NET Ul. You
can send output to Terminal or page, but not to Window. If you select Window, the system displays
an error message. The Winprint option is designed only for Windows clients. If you select this
option, the system displays an error message. Otherwise, the output options are the same in both
interfaces. If you select a printer as the output device, be sure to use one that has been defined with
a destination type of Default in Printer Setup Maintenance (36.13.2). Just as in the QAD .NET U,
you cannot use e-mail unless it has been set up properly.
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Summary

Summary

The Character Ul is available for SE and EE

- In EE, component-based functions are accessible
only through the QAD .NET Ul

Used mainly for highly repetitive heads-down
operator transactions

Exercise

Is the .NET Ul or the character version a better option for your company? Why Or why not?

Go to the sold-to field in Sales Order Maintenance and pull up the drill-down browse, field help,
and procedure help. What key or keys did you use?
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Objective

Objective
- Learn about dashboards in the QAD .NET Ul

- Benefits

- Dashboard Example

- Sample Dashboards

- Dependencies

- How to access QAD Dashboards
- Creating a new dashboard

- Hands-on dashboards

- Dashboard configuration
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Benefits

Benefits

- Brings it all together

- Essential data at a glance

+ Data from browses, metrics, Bl, and web pages
- Easy to customize

- Role-specific

« Sample dashboards available on QAD Store
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Training Flow

Training Flow

« Introduction

+ Navigation

+ Application Help
- Programs

- Browses

« Character Ul

- Dashboards
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Dashboard Example

Dashboard Example
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QAD Dashboards bring together browses, web pages, business intelligence, and metrics within
panels. For example, this slide shows a dashboard you could create to review Large Customer
Orders. The dashboard includes panels that provide information from Sales Order Detail Browse
(using a chart view), Sales Order Browse, a Customer Orders metric, a Top 25 Customers by
Domain and Financial Year — Business Intelligence (Bl) view, and a panel for the QAD web site.
Each panel offers a quick summary; to find out more, you click on the panel to open the item, such
as a browse, within which you can drill-down further for more detailed information. As a user, you
can create, copy, and modify dashboards like this one directly in QAD .NET Ul. Further, you can
save one or more dashboards as favorites and have them open automatically when you log in to the
QAD .NET ULl. As an administrative user, you can publish dashboards for use by others and assign
them one or more user roles defined in the system.
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Sample Dashboards

Sample Dashboards

Sample dashboards available for download from
the QAD Store

- Customer Management Sample Dashboards
Financials Sample Dashboards
Manufacturing Sample Dashboards

Three packages of sample dashboards (Customer Management, Financials, and Manufacturing)
are available for download from the QAD Store. You can copy and customize these sample
dashboards to meet your specific requirements.
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Dependencies

Dependencies

- QAD .NET Ul 3.0.1 (with 2013.1 EE)
+ QAD Business Intelligence (Bl) 3.9

- Required for Bl panels in dashboards

« QAD Operational Metrics

- Required for metrics panels in dashboards
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How to Access QAD Dashboards

How to Access QAD Dashboards

QAD NET Ul {§_} Applications
Dashboards > Create [ Menu Search
Dashboard # 3 Collections
Dashboards > bt
My Dashboards E‘TE Dash;ia,ds
Dashboards = ’:: Create Dashboard

: +-|) My Dashboards
Published Dashboards e

To access QAD Dashboards, in the QAD .NET U, simply navigate to the Dashboards folder in the
Applications pane. In the Dashboards folder, you will see the Create Dashboard selection, with
which you can immediately start creating new dashboards. Under Create Dashboard, we have two
folders: My Dashboards and Published Dashboards. When you create new dashboards, the
dashboards are placed in My Dashboards. When dashboards are made available for your use based
on your user role, these dashboards are placed in Published Dashboards.
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Creating a New Dashboard

137

Creating a New Dashboard

@ Applications = |Pmces:es 2 [Unliﬂed X |
ooy Qo Dashboard Untitled ~ - Add Content ¢ Tools - |2} Save Dashboard M Cancel
* (= Collections
# (= Home Page Add Content to Dashboard [=]
+ () Metrics
=} "% Dashboards H  Browse
B2 Create Dashboard | el x
e igiyey Baatbacads Browse g
Sty 109-MISC Box View (BBcx1099.Vi <]
() Published Dashboards i {'M”;:';f il =
IS sl @ Action Message Browse (drbr002.p) E
= Supply c"‘f" 1 Active Customer Sequence Browse (rebe003.p)
#{3 Manufactuning = URL Add Flow Lines (fibr004.p)
& {3 Financials I Additional Charges Browse (fsbr063 p)
#{(2) Master Data 4 AA Address Type View (BAddressType View)
* () System Administration ' Address \Whse Detail Browse (whbr051.p)
# () Processes b Algorithm Assignment Browse (whbr045.p)
# (= Administration . BI Algorithm Master Browse (whbr043.p)
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In the QAD .NET UI, to create a new dashboard, you simply click on Create Dashboard and get

started with adding Browses, URLSs to web pages, Bl views, and Metrics. From the Add Content to
Dashboard pane, you can select the kind of content you want to have in the various panels of your
dashboard. By default, you can add up to 12 panels on a dashboard, but this default can be changed
by an administrator. Also, note that you can double or triple the size of browse and metrics panels
so that the data is more readily accessible.

Comments? Go to goo.gl/MfwKHm
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Hands-On Dashboards

Hands-On Dashboards
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Now start the QAD .NET Ul to explore how to use and customize dashboards.

1 Go to Dashboards > Create Dashboard.(Alternatively open a dashboard and choose Tools >
New.)

2 Let’s add a browse panel. In the Add Content to Dashboard window,
3 Click Browse

Search for a browse of interest, such as Sales Orders (sobr103.p).
Set Price to be greater than 10,000.

Change Title to: Sales Orders Over 10K.

Preview the browse results.

Click Add to Dashboard.

o N o o A

Next, let’s add a metric panel.
1 Click Add Content.
2 Click Metric.

3 Search for a metric of interest. For example, choose Sales Orders.

M QAD Questions? Visit community.gad.com
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4 Click Configure.

5 Click Metric Gauge.

6 Click Past Due Orders.
7 Click Add to Dashboard.
Now save the dashboard:

1 Click Save Dashboard.

2 Inthe Save dialog, enter a name for the dashboard. You can enter text here but | recommend
that you first check to see if a label is available that would be applicable. By using an available
label instead of text, you can be sure that the title of the dashboard will be translated. For this
example, let’s use the label ${SAMPLE}, which will display in English as “Sample”.

3 When done, click Save Dashboard.

Now, looking back at the Applications pane, under My Dashboards, note that the new dashboard
you’ve just created is located under My Dashboards. However, it is not located under Published
Dashboards.

Edit the new dashboard further:

1 Open the dashboard and click Edit Dashboard. Notice how when you are in edit mode a light
gray grid is displayed in the background. This is to help remind you that you are in edit mode.

2 Now let’s consider the icons near the lower left corners of our panels. You can double or triple
the width of browse panels and metrics panels.

3 Click on the triple-width icon for the browse panel. Note how the browse panel triples in width
and then the metrics panel automatically moves below the browse panel for you.

4 Click Save Dashboard. (Notice the light gray grid is no longer displayed when you are not in
“edit mode”.)

Add some more panels to the dashboard. (By default, we can add up to twelve panels but that limit
can be changed by an administrator.)

1 Open the dashboard and click Edit Dashboard.
2 Inthe Add Content to Dashboard window, click URL.
3 Inthe Title field, enter Google.

4 Inthe URL field, enter a URL to a web page. For example, www.google.com. Note that QAD
Shell Links (gadsh://) links are not currently supported for use in the URL field.

5 Click Preview to verify the view of the web page.
6 Click Add to Dashboard.
7 Click Save Dashboard.

Comments? Go to goo.gl/MfwKHm N QAD
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You can change the configuration of the panels on the dashboard. To see how, edit the dashboard.
Notice the icons along the upper right corner of each panel. There are three of them: a gear, a
circular arrow, and an X. The gear is for editing the panel configuration, the circular arrow is for
refreshing the panel display, and the X is for deleting the panel.

On the URL panel, click on the gear icon and change the URL from www.google.com to
maps.google.com.

Similarly, you can change the configuration of browses, metrics, and so on. For example, you
could change the search filters on a browse display panel.

Take a look at the dashboard tools options.
1 From the dashboard, select Tools.

2 From Tools, you can start a new dashboard, make a copy of the dashboard (which you can then
edit and customize), rename the dashboard (that is, give it a new title), and delete the
dashboard.

3 Next, under Tools, if you are an administrator, you will have a Publish option. When you
publish a dashboard, you have options to rename the dashboard and to assign the dashboard to
user roles previously defined in the system.

4 Finally, under Tools, note the Export and Import options. With these options, you can export
the dashboard definition as an .xml file and then import the .xml file to another system.

You can add a dashboard as a favorite and then set that favorite to auto-start so that it opens
automatically when you log in. For instance:

1 Inthe Applications pane, right click on the Sample dashboard.
2 Choose Add To Favorites.
3 Under Favorites, right-click on Samples and choose Auto Start.

4 Now this dashboard will open automatically when you log in to the Ul again.

M QAD Questions? Visit community.gad.com
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Dashboard Configuration

Dashboard Configuration

« Check dashboard setttings from QAD .NET UI:

+ Help > Configuration, Search: dashboard
- Dashboard Admin Roles
- Dashboard Max Panels (12 default)
- Dashboard Padding
- Dashboard Provider Colors

- Bl access: Bl URL Setting
- Dashboard configuration set by system admin in

client session configuration file on home server
(client-session.xml)

Comments? Go to goo.gl/MfwKHm MNQAD
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Summary

Chapter Summary

- Dashboards provide essential data at a glance
- Data from browses, metrics, Bl, and web pages
« Easy to customize

+ Role-specific

- Sample dashboards available on QAD Store

M QAD Questions? Visit community.gad.com
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Exercise and Knowledge Check

1

With QAD Dashboards, can all of the following be included in dashboard panels?
Browses

Operational Metrics

Business Intelligence (BI)

Web Pages

When you create a new dashboard, where is the dashboard saved on the QAD .NET Ul menu
What is the maximum number of panels you can have on a dashboard by default?
Can you double or triple the width of a browse panel?

Can dashboards be assigned to user roles in the system?

Comments? Go to goo.gl/MfwKHm N QAD
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M QAD Questions? Visit community.gad.com
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Product Information Resources

QAD offers a number of online resources to help you get more information about using QAD
products.

QAD Forums (community.qad.com)
Ask questions and share information with other members of the user community, including
QAD experts.

QAD Knowledgebase (knowledgebase.qad.com)*
Search for answers, tips, or solutions related to any QAD product or topic.

QAD Document Library (www.gad.com/documentlibrary)

Get browser-based access to user guides, release notes, training guides, and so on; use
powerful search features to find the document you want, then read online, or download and
print PDF.

QAD Learning Center (learning.gad.com)*
Visit QAD’s one-stop destination for all courses and training materials.

*Log-in required


http://community.qad.com
http://knowledgebase.qad.com
http://www.qad.com/documentlibrary
http://learning.qad.com
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M QAD Questions? Visit community.gad.com
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